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1 Introduction

The VI-Suite is an open-source add-on to the 3D modelling and animation package Blender that provides a set of

tools for the analysis of environmental factors within and around buildings. It uses Blender’s node system (figure

1) to provide a user interface that allows quick and custom analyses to be created. As of VI-Suite version 0.6

nodes exist for GIS height map import, sun path analysis, wind rose display, shadow and sky view factor studies,

lighting metric prediction, energy performance with advanced airflow network creation and flow analysis with

computational fluid dynamics (Linux only). The lighting, energy and flow analyses are achieved with the three

main VI-Suite components: LiVi, which acts as a pre/post-processor for the Radiance lighting simulation suite

(version 5.3); EnVi, which does the same for the EnergyPlus thermal simulation engine (version 9.3); FloVi, which

interfaces with the OpenFOAM CFD suite (version 8).

Figure 1: Blender nodes

2 Installation

The VI-Suite is packaged as an add-on for Blender and contains all the Radiance and EnergyPlus files required to

run analyses with theVI-Suite. OpenFOAMbinaries are however not included, andmust be installed independently

by the user. On Linux, these binaries can usually be installed by the OS’s package management system.

VI-Suite v0.6 is compatible with the latest LTS release of Blender (currently 2.83.9), which can be downloaded

from (https://www.blender.org/download/lts/). Once Blender has been installed, run Blender and go to the ’Edit’ -

’Preferences’menu and in the preferences window click in the ’Add-ons’ button on the left and then ’Install’ at the

top. Navigate to the zip file downloaded from github (https://github.com/rgsouthall/vi-suite06/archive/master.zip)

and the VI-Suite option should appear in the list of add-ons. Click on the little box on the left to activate the VI-

Suite. The drop-down arrow to the left of the activation box exposes options for the setting of custom Radiance,

EnergyPlus, OpenFOAM (Linux only) and EPW weather file directories.
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3 Configuration

Running Blender launches the main Blender interface, which should look similar to the one shown in figure 2. The

main window is the 3D viewport where the default cube, lamp and camera can be seen. Below this is the animation

timeline, on the top right is the project outliner that contains a list of everything in the scene, and bottom right are

the properties panels where many of Blender’s options and functions reside. At the side of the properties panel

window are tabs to control which panel is visible. The main panels used in the VI-Suite are the "Material" and

"Object" properties panels. Detailed instructions on how to use Blender are beyond the scope of this document, but

there are excellent and free beginners tutorials available online.

3D View

Timeline

Outliner

Properties

Figure 2: Blender interface

Once the VI-Suite has been activated it mostly sits within three node editor windows: “VI-Suite Nodes”, “EnVi

Network” and “EnVi Material”. The Blender interface is, in general, what’s called a non-overlapping interface i.e.

interface areas sit side-by-side rather than on top of each other. Any area can be turned into any other area type by

selecting the type from the drop-down menu at the left-hand side of an area’s header bar, which sits either at the

bottom or the top of each area. For example, the timeline can be turned into the VI-Suite Nodes editor by selecting

"VI-Suite Nodes" in the drop-down menu at the very left of the timeline header.
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4 The VI-Suite Interface

4.1 Changes from v0.4

If you are familiar with the interface of v0.4 there are some changes you should be aware of.

The Blender 2.8 series does not allow multiple node tree types to sit within one node editor window and this is

why there are now three separate node editor windows to cover specific types of functionality. This makes switching

between node tree types a little more cumbersome, so to compensate a “VI-Suite” tab is available in the right hand

context menu of the “VI-Suite Nodes”, “Envi Network”, “EnVi Material” node windows. Within the VI-Suite tab

node, trees that exist in any of the VI-Suite related node windows can be selected and switched between (thanks to

Greg Zaal and the Matalogue add-on for the basis of this functionality).

Blender 2.8 no longer has layers but has instead introduced the concept of collections. Collections are listed

in the ’Outliner’ window at the top right of the Blender interface. Objects can be moved between collections, and

collections can be embedded into other collections by dragging within the Outliner. Results geometry created by

simulations are now placed in their own collections, as is any pre-processed EnVi Geometry.

Unfortunately, Blender 2.8 does not allow the animation of node parameters. This means that any parametric

analysis that involves the changing of a node parameter will not work. This is an accepted to-do for the Blender

developers and if you want to track progress, or add your voice to getting it fixed, the task is assigned at ht-

tps://developer.blender.org/T66392.

4.2 Collections

Collections are the new way in Blender 2.8 and above to organise geometry. This presents some opportunities

for the VI-Suite but also some additional complexity. Collections are created automatically in the VI-Suite to

organise created geometry e.g. the “LiVi Results” stores LiVi results geometry, “SunPath” stores VI-Suite sun

paths. Regular, user-created geometry in Blender will automatically go into the currently active collection, and

this can cause problems if geometry is created into one of these VI-Suite defined collections, as these collections

are sometimes cleared out to make room for new VI-Suite objects. To avoid this make sure that, in general, user

geometry is not resident in these VI-Suite collections when VI-Suite analyses are undertaken.

4.3 File structure

The VI-Suite requires a folder location on the host computer to store files generated during analyses. This folder

is generated automatically when relevant analyses are conducted, and is given the same name as the Blender file,

and in the same location. For example, if the current Blender file is called “VI-Suite.blend” and is saved to the

Desktop, then when required a folder will be created on the Desktop called “VI-Suite”. In the remainder of this

document this folder is referred to as the project directory.

4.4 The Node System

Three types of node editor window are created as part of the VI-Suite and can be selected from the drop-down menu

on the left of each Blender area’s header bar. These three node editors are: “VI-Suite Nodes”, to provide overall

control of VI-Suite simulations; “EnVi Network” nodes to provide the interconnections between zones and zone

properties for EnVi simulations; “EnVi Material” nodes to designate construction layers in EnVi Simulations.

Although these three node tree editors sit in separate windows, and switching between them would normally

require changing the window to another node editor, there is a tab in the right hand sidebar (’n’key toggles visibility)

of each node editor window (figure 3) that allows you to switch between different node editors and node trees.

A node editor view (figure 4) can be panned with the middle mouse button and zoomed with the mouse scroll

wheel. Nodes can be added, deleted, moved, re-sized, collapsed, grouped, linked and unlinked.

Blender nodes can be scripted with Blender’s Python scripting back-end and this allows some user-feedback

features to be implemented. Nodes in general will be red if:

◦ The node contains a operator button which has not yet been pressed
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◦ The options selected within the node are different to the selected options when the operator button was last

pressed

◦ The options selected within the node are invalid within the context of the other nodes the node is connected

to.

Figure 3: VI-Suite node editor menu presenting buttons to switch between all VI-Suite node trees

The node colour will revert to the general Blender theme colour if none of the above conditions are true and

the node, in it’s current state, is valid as a simulation component.

Links between nodes are also scripted so that only valid links can be made. If a link is attempted between two

node sockets the link will immediately disappear if the connection is not valid. Sockets are generally coloured to

show which can be connected (red to red, yellow to yellow etc).

Before any nodes are created the Blender file should be saved to identify the name and location of the project

directory.

In addition to the VI-Suite nodes, visualisation options, when relevant, become available in the 3D view prop-

erties panel in the "VI Display" tab (section 4.5.3).

4.4.1 VI-Suite Nodes

VI-Suite nodes control simulations. An initial VI-Suite node tree has to be created manually by clicking on the

“New” button in the middle of the header bar of the “VI-Suite Nodes” window (“EnVi Material” nodes and “EnVi

Network” nodes are created automatically or by a different method). Only oneVI-Suite node tree should be created.

Once a node tree has been created nodes can be added with the “Add” menu in the node window header bar. There

are six node categories:

◦ “Input nodes” that import data into the VI-Suite

◦ “Process nodes” that export Blender information to a format that can be used for analysis

◦ “Analysis nodes” that run analyses

◦ “Display nodes” that display the results of analyses.

◦ “Image nodes” that process images.

◦ “Edit nodes” that can manipulate data
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◦ “Output nodes” that can export data for third-party analysis.

Figure 4: VI-Suite Nodes editor

4.4.2 EnVi Material nodes

If conducting an EnergyPlus simulation with EnVi, building construction specifications are required. These are

created with “EnVi Material” nodes. An EnVi material node tree is created by clicking on the “Create EnVi Nodes”

button in Blender’s material properties panel. An individual material’s node tree can then be accessed by going to

the “EnVi Material” node window and selecting the node tree, which will have the same name as the material, from

the drop down menu in the middle of the header bar. They can also be selected by clicking on the EnVi material in

the VI-Suite tab in the sidebar of any VI-Suite related node window (figure 3).

In the “Add” menu of an “EnVi Material” node tree are the following categories:

◦ Type node - Type of construction (currently just EnVi Construction)

◦ Layer node - Type of material: opaque, transparent and gas (latter two are mainly for window constructions)

◦ Shading node - Shading layer, blind layer, screen layer, switchable layer, shading control node (experimental

nodes for advanced shading)

◦ Schedule node - sets an EnergyPlus schedule

◦ PV node - Photovoltaic and Photovoltaic generator nodes

When creating an EnVi Material node tree with the “Create EnVi Nodes” button in the material panel a single node

is created by default: an EnVi Construction node.

4.4.3 EnVi Network nodes

If conducting an EnergyPlus simulation with EnVi, characteristics of zones or relationships between zones, or

between zones and the outside, are usually required. These connections are defined by EnVi network nodes. EnVi

network nodes also host Energy Management System (EMS) nodes that can use the EnergyPlus Runtime Language

(ERL) to dynamically control the simulation based on calculated metrics.

In the “Add” menu of an “EnVi Material” node tree are the following categories:

◦ Zone nodes - defines EnergyPlus zone and associated parameters

◦ Schedule nodes - Defines EnergyPlus schedules
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◦ Airflow nodes - defines airflow connections between zones and external air conditions

◦ EMS nodes - defines ERL program elements for runtime control of EnegyPlus simulations.

An EnVi Network node tree is created automatically when an “EnVi Geometry” export is conducted within the

“VI-Suite Nodes” tree and should not be created by the user.

4.5 Other panels

4.5.1 Object properties panel

Figure 5: VI-Suite Object definition tab

The object properties panel is one of the proper-

ties panels situated by default in the lower right of

the Blender interface (figure 2). The object prop-

erties panel define Blender properties at the ob-

ject level. Within this panel there is a tab called

“VI-Suite Object Definition” where the nature of

the object is defined in terms of the VI-Suite. If

the currently selected Blender object is a mesh

then the first menu presented defines the VI-Suite

type.

Type options include:

◦ None - there is no object level specification required. This applies for general lighting simulations, and

shadowing where only the geometric mesh data is required, the properties of which is specified at the material

level.

� Subsequent options allow for the generation of a Radiance octree from the object for use when in-

stancing, triangulation of the mesh before octree generation and using fallback face data, rather than

Radiance meshes, for the octree.

◦ EnVi Surface - the object represents a collection of EnergyPlus constructions.

� Subsequent options define what kind of EnVi surfaces the object represents: construction, shading or

chimney (for thermal chimney)

◦ CFD Domain - the object represents a computational domain for OpenFOAM analysis with FloVi.

◦ CFD Geometry - the object represents an obstruction within a domain for OpenFOAM analysis with FloVi.

◦ LightArray - the object represents an array of artificial lights, via its mesh sub-division, for lighting analysis.

� Subsequent options allow for the selection of an IES file that defines the artificial lighting as well as

the dimensions within the IES file, its strength and colour.

◦ Complex Fenestration - the object represents an element of a repeating geometric array for which a lighting

BSDF is to be generated.

� Direction - defines the direction of the BSDF calculation.

� Proxy - whether to incorporate the geometry into the BSDF for direct light calculations.

* Length unit - converts Blender units to the selected unit for proxied geometry.

� Klem/Tensor - selects the type of BSDF angular subdivision

� Samples - how many samples per sub-division are to be used for the BSDF calculation.

� RC Params - A text box for custom Radiance rcontrib parameters.
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If the object is a Blender “Light” then options are presented to select an IES file, dimension, strength and colour

(in either RGB or colour temperature format).

If the object is a Blender “Empty”, a single option is presented which is to define if this empty should act as an

OpenFOAM probe during a FloVi simulation.

4.5.2 Material properties panel

Figure 6: VI-Suite Material tab

In the material properties panel Blender properties are

defined at the material level. For the currently se-

lected Blender object and currently selected Blender

material (selectable at the top of the material prop-

erties panel) a tab in this panel, called ’VI-Suite

Material’ defines the material in terms of the VI-

Suite.

The “Material type” menu has the following op-

tions:

◦ Geometry - standard lighting geometry

� LiVi Radiance type - defines the type of Radiance material and relevant material parameters

* If LiVi Radiance type is BSDF the following options are presented:

· Proxy depth - the depth of the proxy geometry in metres

· Up vector - the vector in Blender world space that defines the up direction for the BSDF

· Load/Save/Delete BSDF - option to load/save/delete a preexisting BSDF description.

* If the LiVi Radiance type is glass, dielectric, anti-matter or translucent the following option is

presented:

· Photon port - specifies this material as a photon port for photon mapping calculations (the

normal of any associated mesh faces should point inwards)

* If the LiVi Radiance type is not anti-matter, BSDF, custom or light then the following options are

presented:

· Textured - an image texture associated with this material in Blender will be translated to Ra-

diance

· Normal map - if “Textured” is selected and a normal map is associated with the materiel in

Blender this will be translated to Radiance

· Strength - strength of the normal map

· Vectors for the green and red components of the normal map in Blender world coordinates

◦ Light sensor - defines thematerial as a lighting sensor surface for LiVi, shadowmapping and SVF calculations

◦ FloVi boundary - sets a boundary condition for an OpenFOAM simulation. Options here are:

� Netgen Cell size - maximum cell size of the Netgen generated mesh on the vertices and edges of the

geometry associated with this material.

� Type - sets the type of boundary:

* Patch - for inlets/outlets

* Wall - for solid boundaries

* Symmetry - a symmetry boundary

* Empty - no boundary

� For the Patch and Wall boundary types the further options define the boundary properties for each of

the variables being solved (refer to OpenFOAM documentation for more details)

� Probe - defines this material as a probe surface for result export.
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4.5.3 Visualisation panel

Control of the visualisation of results within Blender’s 3D View is done within 3D viewport sidebar, which can be

opened and closed with the ’n’ key while the mouse is over the viewport. Within the sidebar there is a tab called

“VI-Suite”. At the bottom of this panel is the "VI-Suite" tab (figure 7), which will get populated with visualisation

options as they become available. The example in figure 7 shows sun path visualisation options.

Figure 7: VI-Suite Display tab

VI-Suite v0.6 also has a display framework that will create icons in the 3D view for the visualisation of certain

analysis results. The icons will appear, when appropriate, in the upper left of the 3D viewport. If these icons are

clicked a data window will appear. Clicking and dragging on upper left corner of the data window will move it

around the 3D view and clicking and dragging the bottom right of the data window will resize it. The full list of

icons that can be created is presented below although the actual icons created depend on the analysis context.

◦ Legend display - this will display a colour bar that relates numerical value to colouration within the 3D

scene.

◦ Table display - this will display tabulated results.

◦ Heatmap display - this will display a heatmap of the chosen results (days along the x-axis and hours on

the y)

◦ BSDF display - this will display a Klems tree visualisation of a calculated or loaded BSDF.

At the bottom of the "VI-Suite Display" tab is a ’Display active’ toggle. It is good practice to turn this off before

initiating another simulation or when finished with the display of results.
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4.6 Common Nodes

Common nodes are nodes that do not belong to any particular simulation pipeline.

4.6.1 The VI Location node

Figure 8: VI Location node

AVI Location node can be added from the "Add" - "Input nodes"

menu entry in the “VI-Suite Nodes” window. The VI Location

node sets the location of the context to be analysed in terms of

latitude and longitude and, if required, hourly weather data from

an EPW format weather file. This node is a required node for sun-

path, solar shading, wind rose, energy and most lighting analyses.

The source of the information provided by this node can either

be entered manually by the user (adequate for sun-path, solar shad-

ing and some lighting analyses) or generated from an EnergyPlus

weather (EPW) file (required for wind rose, energy and CBDM

analyses but can be used for any location based analysis type).

This choice is made with the node’s first drop-down menu. If the

"Manual" option is chosen here then the user can enter site latit-

ude and longitude (longitude is in the range -180 to 180 degrees

with West of the Greenwich meridian having positive values) in

the two number dialogues in decimal format. If "EPW" is chosen

then a new drop-down menu appears with a list of registered EPW files. EPW files are registered by placing them

either in the "EPFiles/Weather" folder within Vi-Suite script folder or the custom directory specified in the VI-Suite

add-on settings. The EPW files should have a ".epw" or ".EPW" extension. A good source of EnergyPlus weather

files is http://apps1.eere.energy.gov/buildings/energyplus/weatherdata_about.cfm, but they are a common format

and can be found at many sites for a wide variety of locations.

The VI Location node has one output socket, a light green "Location out" socket, which can connect to any

light green "Location in" socket. If an EPW weather file is selected the ’Location out’ socket can also connect to

the green input socket of the VI Chart node for plotting of the weather data.

4.6.2 The ASC Import node

Figure 9: VI ASC import node

ASCII formatted Esri Grid files are GIS data files

which can represent ground elevation data in text file

format. These files often have the extension .asc and

are referred to as ASC files here. ASC files can be ex-

ported by the Edina DigiMaps web service that contain

accurate terrain height data for the whole of the UK.

TheASC import node can be added via the "Input"

nodes menu in the “VI-Suite Nodes” window. The

node contains two toggle options, a menu and an op-

erator button. The toggle options are:

◦ "single". If on, only theASC file selected is imported. If off, allASC files within the directory of the selected

ASC file will be imported.

◦ "splitmesh". If multiple ASC file are imported this option creates separate meshes for each file. ASC files

from DigiMaps are separated by the map grid squares selected for export. DigiMaps can also supply images

of roads, building locations etc for each of these map grid squares and turning on "splitmesh" can make

mapping these images to the geometry imported into Blender easier.

The menu defines what happens if there is missing height data. If “Zero” is selected any missing height data will

be given a value of zero, if “Delete” is selected the missing data is not imported.
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The operator button converts theASC file into Blender co-ordinates and creates a mesh within the scene which

accurately represents the ground heights in the ASC file. Once this geometry has been imported it can be subject

to further analysis, for example a shadow study (section 4.7.4).

4.6.3 The VI Chart node

Figure 10: VI Chart node

TheVIChart node (figure 10) usesMatplot-

lib http://matplotlib.org/ to provide simple

line plotting for certain types of data. As

of version 0.6 this chart node can plot cli-

mate data from an EPW file selected within

a "VI Location" node, results data from an

"EnVi Simulation" or "EnVi Results file"

node and results from the ’LiVi Simulation’

node. Initially only the X-axis socket is ex-

posed. Once this socket is connected a "Y-

axis 1" socket is exposed. Once this socket

is connected a "Y-axis 2" socket is exposed, which should again be connected to the same "Results out" socket.

In total three "Y-axis" sockets can be exposed. It is possible to connect different result source nodes to the input

sockets of this node but the result length coming from each source node must be the same or an error will occur.

Next to each connected socket menu items will appear to select the type of data to plot on the axis. This contents

of these menu items depends on the contents of the results embedded in the connected node.

A "Create plot" button in the middle of the node creates the Matplotlib plot in a new window. Buttons within

this new window allow some manipulation of the chart and export to image file (see Matplotlib documentation for

more details). The options presented by the node are:

◦ Animated - whether the results of a static analysis or the results acress a parametric analysis are to be con-

ducted.

◦ Day - start and end day of the period to be plotted. Defaults to the total day range of the results connected to

the sockets.

◦ Chart type - Line/Scatter for line (only line is currently supported)

◦ Frequency - Hourly, daily, monthly results plotting

◦ DPI - the DPI of the resulting grpah

As each socket is connected menus will appear for the type of result, the specific result and to specify a multiplic-

ation modifier.

4.6.4 The VI CSV Export node

Figure 11: VI CSV Export node

The “VI CSV Export” node can take the results from simu-

lation nodes that have a “Results out” output socket and con-

verts them to CSV format. The CSV formatted data can then

saved to a file for third-party visualisation/processing. If the

results from the simulation contains parametric data the node

will expose one option which toggles whether only the anim-

ated parametric data or the complete static data set is expor-

ted. The “Export” button will open up a file save window and

the name and the destination of the CSV file can be specified.
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4.6.5 The Text Edit Node

Figure 12: VI Chart node

The ’Text Edit’ node in the ’Edit Nodes’ menu allows for

an information pipeline to be interrupted for manual editing

within Blender’s text editor. This node currently only works

with the LiVi simulation pipeline. Once a LiVi Geometry or

Context node is connected to the ’Text in’ socket the Radi-

ance input text is loaded into Blender’s text editor. The name

of the text file within the text editor is also shown within the

node. If any changes are made to the text in the text editor

an ’Update’ button appears within the node. When pressed

the updated text is loaded into the node and will be presen-

ted to any ’LiVi Simulation’node connected to the ’Text out’

output socket.

4.6.6 The VI Metrics node

Figure 13: The VI Metrics node

The “VI Metrics” node replaces the compliance test-

ing methodologies in v0.4 and can benchamrk sim-

ulation results based on particular lighting and en-

ergy standards. The lighting metrics currently sup-

ported are LEED, BREEAM and RIBA 2030 Cli-

mate Challenge. Energy metrics are SAP and

RIBA 2030. The VI Metrics node can also

present results from probes embedded in flow sim-

ulations. The example in figure 13 shows the

lighting Daylight Factor results and their compar-

ison to RIBA 2030 recommendations. The node

has a single socket input that connects to the “Res-

ults out” socket of LiVi, EnVi and FloVi simulation

nodes.

Options within this node include:

◦ Type - sets the metric type: Lighting, Energy and Flow are currently supported.

◦ Metric - sets the specific benchmark for comparison

◦ Frame - sets the animation frame if doing a parametric analysis

◦ Zone - sets the zone name for comparison, based on the Blender object, collection or empty name if conduct-

ing a lighting, energy or flow comparison respectively.

4.7 Specific Analysis Nodes

Analysis nodes can be found in the "Add" - "Analysis nodes" menu in the VI-Suite node tree. Analysis nodes

initiate actual calculations. Some analysis nodes need to be part of a larger node set-up, for example LiVi and EnVi

simulation nodes, whereas others represent a complete analysis, for example wind rose and shadow study nodes.

These standalone analysis nodes are described here.
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4.7.1 The VI Wind Rose node

Figure 14: VI Wind Rose node

The “VI Wind Rose” node takes wind data from an EPW weather

file and creates a wind rose plot. The "VIWind Rose" node has one

input "Location in" socket that connects to a “VI Location” node

"Location out" socket. As EPW data is required, EPWmust be se-

lected as a source of information in the "VI Location" node. Once a

valid "Location in" socket connection has been made a drop-down

menu specifying the type of wind rose to plot (two types of histo-

gram, and three types of contour, plot are currently available), two

numerical input fields to specify the start and end day for the wind

rose data, a colour menu to select the colouration of the created

wind rose and one "Create Wind Rose" button are exposed. Upon

pressing the "Export" buttons a new wind rose object is created

within the Blender scene which can be scaled, moved or rotated as

desired. Wind rose specific display options are also revealed in the

"VI Display" tab (section 4.5.3).

4.7.2 The VI Sun Path node

Figure 15: VI Sun Path node

The "VI Sun Path" node shown in figure 15 creates an object within the

Blender scene for a sun path visualisation (section 5.1). As the sun path ana-

lysis requires latitude and longitude data this node has one input socket "Loca-

tion in" which connects to a "VI Location" node’s "Location out" socket. The

node contains one menu that defines the suns created:

◦ Single - single sun for a single point in time.

◦ Hourly - a sun is created for each hour of a particular day if it is above

the horizon

◦ Monthly - a sun is created for each month at a particular time if it is

above the horizon.

Once a valid "Location in" socket connection has been made a button is exposed to create the sun path. Once the

sun path object is created, options appear in the "VI-Suite Display" tab (section 4.5.3) to control the day, time and

size of the sun path objects for real time visualisation of sun position.

4.7.3 Sky View Factor node

Figure 16: VI SVF node

The “VI SVF” node in the “Analysis Nodes” menu gener-

ates a sky view factor analysis on sensing geometry des-

ignated by the application of a light sensor VI-Suite ma-

terial to the faces of the sensing geometry. Sky View

Factor is the proportion of the sky that can be seen from

each sensor point and can be useful for the study of

urban contexts. The “VI SVF” node is a stand-alone

node is it needs no other nodes in order to conduct a

calculation. The node contains one output socket: a

’Results out’ socket to send the results to a “VI-Chart”

node or a “VI CSV” node for additional processing.

Any exported CSV file will contain the x, y, z position

of the sensing points and the sky view value at those

points.

Options within the node are:
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◦ Ignore sensor - turning this on will exclude the sensing geometry from the sky view calculation. This should

be turned on when conducting analysis on fictitious or arbitrary planes, and turned off for physical sensing

geometry such as terrain.

◦ Sky patches - this controls the resolution of the sky patches for the view factor analysis (figure 17)

◦ Result point - to specify whether the sky view sensing points are positioned at the face centre or vertices of

the sensing object

◦ Offset - to specify the distance of the sensing point from the geometry (this is useful if the sensing mesh has

non-planar faces that would place the centre of the face below the face surface). If the results are inexplicably

zero for some result points try increasing this number.

The node also contains one operator button to conduct the calculation. Once a calculation has been conducted a

’Sky View Display’ button will appear in the 3D Viewport sidebar “VI-Suite” tab.

Figure 17: Sky View Patches (Tregenza, Reinhart 577, Reinhart 2305)

4.7.4 The VI Shadow Map node

Figure 18: VI Shadow Study node

The “VI Shadow Map” node (figure 18) colours sensing geometry

based on the proportion of time the geometry is exposed to direct

sunshine assuming clear sky conditions. The calculation is done

every specified interval during month and hour range specified if

the sun is above the horizon. The node has one input socket; "Loc-

ation in" which connects to a VI location node’s "Location out"

socket. The VI Location node can have either manual or EPW

specified latitude and longitude. The node also has a “Results out”

socket for connection to a “VI Chart” node for plotting, or a “VI

CSV” node for exporting the calculated data to a csv formatted text

file.

Once a calculalation has been done a Node options, which are

only displayed once a valid socket connection has been made, in-

clude:

◦ Ignore sensor - when turned on shading sensor surfaces do

not shadow other shading sensor surfaces.

◦ Animation - to specify whether geometry is animated or static.

◦ Start & end day - to specify the day range for analysis.

◦ Start & end hour - to specify the daily hour range.

◦ Hour steps - number of steps per hour to calculate.

◦ Result point - to specify whether the shadow sensing points are positioned at the face centre or vertices of

the sensing object
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◦ Offset - to specify the distance of the sensing point from the geometry (this is useful if the sensing mesh has

non-planar faces that would place the centre of the face below the face surface). If the results are inexplicably

zero for some result points try increasing this number.

4.8 LiVi Nodes

The lighting analysis nodes control and specify a LiVi simulation for the prediction of lighting metrics. Most of

the lighting analysis nodes ("LiVi Geometry", "LiVi Context") can be added via the "Process nodes" menu. "LiVi

Simulation" can be added from the "Analysis nodes" menu.

4.8.1 The LiVi Geometry Export node

Figure 19: LiVi Geometry node

The ’LiVi Geometry’ node (figure 19) exports Blender geometry

and materiality to a format that can be understood by the Radi-

ance lighting simulation suite. All unhidden lights, geometry (that

has the VI-Suite object definition “Geometry”) and materials in

the Blender scene layer are exported and the Radiance description

stored within the node. Some geometry options here are:

◦ Triangulate - will triangulate the mesh before Radiance ex-

port. This may be useful where the meshes contain weird

N-gon geometry.

◦ Fallback - if enabled each mesh face is written out individu-

ally to Radiance format. If disabled Radiance meshes are

exported for each Blender object (the latter option can be

slower but allows texturing and normal mapping).

If the animated option is selected a Radiance description for each

frame selected with the node’s frame range options is written. A

Blender animation covering the selected frames should have been

created previously. Subsequent options control the point type on any sensing geometry at which results will be

calculated (vertices or faces), and the offset in metres for the sensing point from the actual geometry. This option is

useful for non-planar surfaces where the average central point of a face centre is actually below the face surface. If

calculated results are inexplicably zero on some faces try increasing this value. The node has one ’Geometry out’

output socket that can connect to a ’Text in’ or ’Geometry in’ socket.

4.8.2 The LiVi Context node

The LiVi Context node (figure 20) controls the export of a lighting simulation context to a text format that Radiance

can understand. In terms of a Radiance simulation, context means the type of sky the building is exposed to, the

time of day and year and the metric to be calculated. On export the sky context is stored within the node. This node

can create two different categories of sky context: ’Basic’, for simple lighting metrics, and ’CBDM’ for climate

based daylight modelling.

The node has one input socket and one output socket. The input socket is a "Location in" socket for connection

to a VI location node’s "Location out" socket. This connection is required to expose the node’s export button. The

output socket is a "Context out" socket for connection to a “Text in” socket or a “LiVi Simulation” “Context in”

socket.

Node options are dynamic and presented only if appropriate for the type of analysis selected, which is set with

the first “Context” menu. The “Context” menu menu options are:

◦ Basic:

� Program - sets the sky generator

* Gensky - uses Radiance’s Gensky program to generate the sky
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· Sky type - sunny, partly coudy, cloudy, daylight factor skies are supported

· Turbidity - sets the turbidity for the sky

* Gendaylit - uses Radiance’s Gendaylit program to generate the sky

· Spectrum - choose visible or full spectrum radiation

· Colour sky - Enables a coloured sky description

· Epsilon - sets the epsilon value for the generated sky

· Delta - sets the delta value for the generated sky

* HDR Sky - allows the loading of an existing HDR image as a Radiance sky texture

· HDR format - ’Angular’ for angular maps and ’Polar’ for conventional latitude-longitude

format (equirectangular in Blender)

· HDR rotation - environment map centre is south by default, a degrees rotation can be specified

with this option.

· HDR distance - radius of the sphere in metres upon with the Radiance sky texture is mapped

* Radiance Sky - allows the loading of a pre-existingRadiance text file sky description fromBlender’s

text editor

* None - no sky

� Ground ref - sets the ground reflectivity

� Ground col - sets the ground colour

� Start hour - hour time for sky creation (beginning hour time if animated)

� Start day - day of the year for sky creation (beginning day time if animated)

� Animation - sets a parametric sky creation. End day and hour and interval are subsequent options and

the start frame and calculated end frame are shown.

� HDR - creates an HDR image of the sky in the project directory that can be used as an environment

texture in Blender.

(a) LiVi Basic (b) LiVi CBDM

Figure 20: LiVi Context node

◦ CBDM

� Type:

Dr Ryan Southall 17 School of Architecture & Design



VI-Suite v0.6 4 The VI-Suite Interface

* Exposure - generates a composite HDR image of the sky for the simulated duration for exposure

calculations

* Hourly irradiance - calculates full spectrum irradiance exposure for each hour of the simulation

* DA/UDI/SDA/ASE - calculates conventional CBDM metrics

· (s)DAMin lux - sets the minimum lux level for (spatial) Daylight Autonomy

· UDI Low (Max) - sets the maximum lux level for the Useful Daylight Illuminance (UDI) low

level

· UDI Supplemental (Max) - sets the maximum lux level for the UDI supplemental level

· UDI Autonomous (Max) - sets the maximum lux level for the UDI autonomous low level

· ASE level - sets the upper limit for ASE calculations.

◦ All year - does the calculation for an entire year

� If off, start and end day and hour can be set

◦ Weekdays - only calculate a sky for weekdays if, for example, simulating a commercial environment

◦ LEED v4 - sets ASE and (s)DA levels for a LEED v4 calculation

◦ Source file:

� EPW - generates sky data from the EPW file selected in the “VI Location” node

� HDR - use a pregenerated HDR sky for exposure calculations

� VEC - use a pre-generated vector description of a sky for CBDM and irradiance analyses

◦ Resolution - sets the patch resolution for the generated sky (1 = 147 patches, 2 = 578 patches)

◦ HDR - generates a composite HDR panorama of the sky in the project directory.

If valid socket input connections have been made an ’Export’ button will appear at the bottom of the node. Clicking

this will export the context to Radiance format and stores it within the node.

4.8.3 The LiVi Simulation node

The LiVi Simulation node (figure 21) calls the rtrace component of Radiance to calculate the chosen metric on the

sensing geometry.

Figure 21: LiVi Simulation node

The node has two input sockets: "Context in", which accepts

connections from a "Context out" socket of a “LiVi Context” node

and "Geometry in" for connection to the "Geometry out" socket

of a "LiVi Geometry" node. Once valid socket connections have

been made the node options are exposed. This node shows the cur-

rent range of frames for which a Radiance simulation will be con-

ducted which is a combination of the frame range from the con-

nected geometry and context nodes. The "Accuracy" menu con-

trols the simulation accuracy, with more accurate values leading

to longer simulation times. The options presented in this menu de-

pend on the type of analysis being conducted: a LiVi Basic analysis

presents "Low", "Medium", “High" and "Custom" options. LiVi

Compliance and CBDM analyses give rise to "Initial", "Final" and

"Custom" options. A "Custom" selection allows for the input of

Radiance command line options into the exposed text box.

The node also contains options for Radiance’s new photon

mapping capability. At least version 5 of Radiance is required to

use photon mapping. Photon mapping options include the number of global and caustic photons emitted, cus-

tom photon map parameters and photon map preview. Refer to the Radiance photon mapping manual for more

information about these options.
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If a basic “LiVi Context” has been exported a Blender camera selection menu and “Preview” button will be

shown. Pressing this “Preview” button will bring up a Radiance rvu window and visualise the scene from the

perspective of the chosen camera.

The "Calculate" button, which is only visible if there is valid sensing geometry, initiates the rtrace simulation.

When the "Calculate” button is pressed the Blender interface will lock up during the simulation but a kivy window

will appear that shows an estimate of simulation duration and presents a cancel button to terminate the simulation.

4.8.4 The LiVi Image node

A “LiVi Image” node can be added to the node tree with “Add > Image Nodes” menu in the “VI-Suite Nodes”

window. The “LiVi Image” node creates a Radiance image from the the “LiVi Geometry” and “LiVi Context”

nodes and has the same input socket connections as a “LiVi Simulation” node. At the top of the node the frame

range generated by the “LiVi Geometry” and “LiVi” Context nodes will be shown. Images will be created in the

“project directory > images” folder with the name basename-frame.hdr and will be registered in Blender’s image

editor.

Figure 22: LiVi Image node

Once valid socket connections are made and a Blender camera

selected with the drop down box, options in the node will appear.

These options include:

◦ Camera - Blender camera selection menu

◦ Base name - base name for the images produced

◦ Illuminance - turns on an illuminance image rather that a

luminance image (illuminance images will make all initial

ray hits based on white, diffuse geometry)

◦ Fisheye - creates a fisheye image (for glare analysis)

� FOV - field of view in degrees (should be 180 for glare

analysis)

◦ Accuracy - sets the Radiance accuracy (same as the “LiVi

Simulation” node)

◦ Photon map - turns on the Radiance’s photon mapping cap-

ability

� Global photons - sets the number of global photons

� Caustic - sets the number of caustic photons

� Photon options - custom photon mapping options

� Preview photons - creates an image with a preview of

the photon distribution (fallback LiVi geometry export

may need to be turned off for this to work)

◦ Preview - creates a preview of the scene with Radiance’s rvu

program

◦ X resolution - sets the X pixel resolution of the image

◦ Y resolution - sets the Y pixel resolution of the image

◦ Multi-thread - on Linux and OS X enables multi-processing

� Processors - sets the number of processors available for multi-processing

� Processes - splits the image into this many segments for multi-processing
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◦ Image - creates the image(s)

4.8.5 LiVi Glare node

The “LiVi Glare” node can be added from the “Add > Image nodes” menu in the “VI-Suite Nodes” window and

connects to the output of a “LiVi Image” node and processes the images created to evaluate glare probability.

Figure 23: LiVi Glare node

Glare analysis works on fisheye images so the fisheye option

should have been selected in the “LiVi Image” node. The “Illumin-

ance” option should also be turned off in the “LiVi Image” node.

In addition glare analysis on fisheye images larger than 800x800

pixels can take a long time. Glare images are stored in the “Project

directory > images” folder.

The node contains two options:

◦ Base name - sets the base name of any generated images

◦ Random - randomly colours glare sources

� If not selected then a single colour for all glare sources

can be selected

4.8.6 LiVi False Colour node

Figure 24: LiVi False Colour node

The “LiVi False Colour” node can be added to the node tree with

the “Add > Image nodes” menu in the “VI-Suite Nodes” window.

The “LiVi False Colour” node applies a false colour filter to LiVi

images. This filter colours the image according to the lighting data

embedded within it. The type of data embedded in the image de-

pends on options in the “LiVi Context” and “LiVi Image” nodes.

If the LiVi context images are generated with the “Visible” spec-

trum option in the “LiVi Context” node then illuminance (lux) or

luminance (cd/m2) data is available. Which is of these is available

is determined with the “Illuminance” option in the “LiVi Image”

node. If the “Full” spectrum option is used in the “LiVi Context”

node then irradiance (W/m2) and radiance (W/m2.sr) are available,

again switched between with the “Illuminance” option in the “LiVi

Image” node.

Once a legend unit has been entered the options within this

node include:

◦ Base name - base name for the false colour image

◦ Unit - sets the legend unit

◦ Multiplier - sets a multiplication or division factor for the

results (/100 would divide the results by 100, *100 would

multiply by 100)

◦ Colour - sets the legend and image colour scale

◦ Divisions - sets the false colour divisions
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◦ Legend - turns on legend display

◦ Scale - sets the legend number scale: linear or logarithmic

◦ Legend max - sets the maximum legend number

◦ Legend width/height - sets the display width/height of the

legend

◦ Contour - draws contours over the image

� Overlay - overlays the contours over an image

* Overlay file - selects the image to overlay contours

* Sets the exposure (as multiplier) of the overlaid image

* Bands - thickens the contour colouration
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4.9 EnVi Nodes

EnVi nodes control the main phases of an EnergyPlus simulation: The “EnVi Geometry” node processes Blender

geometry for export; the “EnVi Export” node exports processed geometry and context to EnergyPlus format; the

“EnVi Simulation” node runs the Energyplus simulation.

4.9.1 The EnVi Geometry node

Figure 25: EnVi Geometry node

The “EnVi Geometry” node (figure 25) processes Blender scene

geometry and materiality into a form more suitable for EnergyPlus

analysis, which requires a very different level of geometric detail

than that typically used within Blender. The node contains one

"Export" operator button. Upon pressing the "Export" button the

node processes all visible geometry, designated as EnergyPlus geo-

metry with an EnergyPlus material, and displays it in Blender with

a positional offset set with the ’Offset’ value within the node. This

new geometry is also placed in the “EnVi Geometry” collection, with sub-collections based on the collection or-

ganisation of the original geometry.

After changes are made to to the original geometry the "Export" button should be re-pressed to reprocess. The

node has one output socket, "Geometry out" for connection to an “EnVi Export” node’s "Geometry in" socket.

4.9.2 The EnVi Export node

Figure 26: EnVi Export node

The “EnVi Export” node converts the modified Blender geo-

metry and materiality within the “EnVi Geometry” collec-

tion to a valid EnergyPlus text description and combines it

with the weather data specification in the connected “VI Loc-

ation” node, which must have "EPW" selected as its in-

formation source. The context and desired simulation met-

rics presented within this node complete an EnergyPlus text

input file. The input file created is called in.idf and is

stored in the project directory. It is also registered within

Blender’s text editor, and can be edited before eventual sim-

ulation if required. The node has two input sockets: "Geo-

metry in" for connection to an “EnVi Geometry” node’s "Geo-

metry out" socket and "Location in" to connect to a “VI Loc-

ation” node’s "Location out" socket, and one output socket

"Context out", for connection to an EnVi simulation node’s

"Context in" socket. If valid input socket connections are

made an "Export" button will appear at the bottom of the

node.

Options include:

◦ Shadow - sets the method for shading calculations: CPU

uses the cpu, GPU uses the graphics card. GPU can be

quicker if there are a large number of shading surfaces.

◦ Animation - designates an animated/parametric EnergyPlus

export

� Start frame - sets the beginning frame for the parametric analysis

� End frame - sets the end frame for the parametric analysis
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◦ Name/location - provides a text box for the optional entry of an EnergyPlus project name

◦ Terrain - specifies the type of terrain the building sits in.

◦ Start/end day - specifies the beginning and end day for the simulation.

◦ Time steps - specifies the number of simulation time steps per hour

◦ Results category - chooses the class of metrics to be calculated. Options are "Zone Thermal", "Comfort",

"Zone Ventilation", "Ventilation Link", “Thermal chimney” and “Power”.

� Individual tick boxes for specific metrics within the chosen results category class.

Upon pressing the “Export” button the in.idf file is created in the project directory and the "Context out" socket

will become visible.

4.9.3 The EnVi Simulation node

Figure 27: EnVi Simulation node

The EnVi Simulation node (figure 27) initiates an EnergyPlus sim-

ulation. The EnVi Simulation node has two sockets: "Context in"

for connection to another node’s "Context out" node, and "Results

out" for connection to a "VI Chart" node or a "VI CSV Export"

node. The node contains a text box into which the name of the

EnergyPlus results file (default is "results") can be specified. This

file, with the extension .eso, is saved in the project directory. Once

a valid socket connection has been made to the "Context in" socket

a "Calculate" button appears, which when pressed initiates the En-

ergyPlus simulation. The node will then turn red and will monitor

the EnergyPlus simulation and give a prediction of simulation pro-

gress with a Kivy window. The Blender interface should remain

interactive during simulation but no changes to the Blender scene

should be made while the simulation is running.
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4.10 EnVi Network Nodes

EnVi Network Nodes are used within the EnVi Network node tree to specify zone schedules and natural ventilation

networks.

4.10.1 The EnVi Zone nodes

EnVi zone nodes are created automatically in the "EnVi Network" node tree during EnVi geometry conversion.

Input sockets are created for HVAC, occupancy, equipment and air infiltration schedules. If a Blender object’s

“EnVi Material” nodes has the airflow surface or zone boundary surface option turned on, sockets are also created

for these surfaces. These sockets are coloured brown if representing a boundary surface, green if representing a

sub-surface flow component associated with opening surfaces like windows or doors, and red for a surface flow

associated non-opening surfaces such as walls, floors and roofs. These sockets are created on both sides of the node

for easier arrangement of connections within the node editor.

Figure 28: EnVi Zone node

The example in figure 28 shows a basic zone node with two

sub-surface (windows & doors) sockets. These two flow compon-

ents originally express themselves as two input sockets and two

output sockets but if a socket is connected the same socket on the

opposite side will disappear (the example in figure 28 shows one

connected airflow socket as an input and one connected as an out-

put), with socket names derived from the name of the material as-

sociated with the surface, the index number of the Blender face

and at the end of the socket name an "s" denotes a surface flow

and "ss" denotes a sub surface flow. A "b" at the end of the socket

name would denote a boundary surface. For example, Glass_5_ss

denotes that Blender material “Glass” is associated with a face with

an index of 5 that represents a sub-surface flow. The VI-Suite it-

self does not by default visualise face index number but this can

be turned on by enabling “Developer Extras” in Blender’s interface

preferences. Selected face indices can then be visualised by select-

ing the ’Indices’ option in the ’Overlays’menu of the 3D Viewport

when a mesh is in edit mode.

Boundary sockets should be connected to another boundary

socket on another zone node. The VI-Suite then assumes that the

connected boundary surface sits on the boundary between these

two zones. If a boundary node is left unconnected the VI-Suite

will consider this an external boundary as if an “External” bound-

ary condition had been set for the associated face material.

Surface and sub-surface flow sockets must be connected to an

’EnVi Surface flow’ node (section 4.10.7) or an ’EnVi Sub-surface flow’ (node section 4.10.8) respectively.

An additional input socket "VASchedule" is optional and allows the specification of a venting availability sched-

ule for the zone.

When all airflow sockets are connected the node becomes valid and will turn the default colour. It should be

noted that if airflow surfaces are designated then any EnVi zone must have at least two airflow surfaces specified

within it during geometry creation, and at least two sets of flow sockets should appear in the node.

The node also displays the name of the Blender object/EnergyPlus zone, the interior and exterior heat convection

algorithms, the calculated volume of the node and the ventilation control type. Ventilation control type options are:

◦ None - no control of ventilation

◦ Constant - ventilation is always permissable

◦ Temperature - If "Temperature" is selected a new input socket "TSPSchedule" must be connected to an EnVi

schedule node. This schedule will set thermostat temperature set-points above which the openable zone

airflow connections will all considered to be fully open. Some extra options are then also displayed:
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� Minimum OF - the minimum opening factor

� Lower - the lower temperature difference threshold

� Upper - the upper temperature difference threshold

See the EnergyPlus input/output reference file for details on these options.

4.10.2 The EnVi HVAC node

Figure 29: EnVi HVAC node

The “EnVi HVAC” node is available in the “Add - Zone

Nodes” menu in an “EnVi Network” node tree and spe-

cifies heating and cooling levels for a connected “EnVi

Zone” node by creating an EnergyPlus IdealLoadSys-

tem. EnergyPlus was developed in the United States

where the heating and cooling of buildings with air is

common and many of the EnergyPlus options pertain-

ing to the supply of heating and cooling reflect this.

◦ HVAC Template - whether an HVAC template

should be used (as of v0.6 only an ideal load

air system has been implemented and this option

therefore only duplicates the action of this node).

◦ Heating limit:

� None -no heating.

� No limit - heating is unlimited in terms of

the air flow rate that can be supplied or the

capacity to heat the air.

� LimitFlowRateAndCapacity - limit the

overall capacity and the airflow rate of the

heating system.

� LimitCapacity - limit only the overall capa-

city of the heating system.

� LimitFlowRate -limit only the airflow rate

of the heating system.

◦ Heating temp - temperature of the heating air-

flow.

◦ Heating airflow - maximum air flow rate (m3/s)

if air flow is limited.

◦ Heating capacity - maximum heating capacity (Watts) if capacity is limited.

◦ Thermostat level - thermostat set-point for heating.

◦ Heat recovery - turns on sensible heat recovery.

� HR eff. - sets the heat recovery efficiency

Most of these options have their corollary in the cooling section of the node. The level of outdoor air supplied by

the heating/cooling system can also be specified. If the outdoor air flow level is higher than the flow supplied by

the heating/cooling system the latter is supplied. See the EnergyPlus Input Output reference document for details

of the outside air supply options.

In addition, the node has three input sockets:
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◦ Schedule - for the connection of a schedule node to determine when the heating/cooling system is available

(schedule values: 0 or 1).

◦ HSchedule - for the connection of a schedule node to provide time varying heating thermostat set point

temperatures (schedule values: temperature).

◦ CSchedule - for the connection of a schedule node to provide time varying cooling thermostat set point

temperatures (schedule values: temperature).

4.10.3 The EnVi Occupancy node

Figure 30: EnVi Occupancy node

The EnVi Occupancy node is available in the “Add -

Zone Nodes” menu in an “EnVi Network” node tree

and specifies the type and nature of any occupancy

within a connected EnVi zone node. Occupancy is set

as a maximum occupancy level within this node and an

attached schedule node can set the fractional schedule

of this maximum level. The options within the node

control:

◦ Type of occupancy:

� None - no occupancy.

� Occupants - occupancy in terms of number

of people.

� Persons/m2- number of people per square

meter of floor area.

� m2/person - square meter of floor area per

person.

◦ Max level - maximum occupancy in terms of the

previously selected occupancy type.

◦ Activity level - watts per persons metabolic rate.

◦ Comfort calc - turn on thermal comfort calculations

� Work efficiency - proportion of the metabolic rate expended in useful work.

� Air velocity - average air velocity for comfort calculation.

� Clothing - clothing level of the occupants in clo.

� CO2- turn on the calculation of internal CO2 levels.

The node also contains sockets for the connection of schedule nodes: OSchedule socket is for the scheduling of

occupancy level as a proportion of the maximum specified occupancy; ASchedule socket for the schedule of the

absolute metabolic rate; WSchedule for the scheduling of the absolute level of the work efficiency; VSchedule for

the scheduling of absolute air velocity in m/s; CSchedule for the scheduling of absolute clothing level.

4.10.4 The EnVi Equipment node
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Figure 31: EnVi Equipment node

The EnVi Equipment node is available in the “Add - Zone

Nodes” menu in an “EnVi Network” node tree and specifies the

level of mechanical and electrical internal heat gains. The node

contains one “Equipment” output socket for connection to the

“Equipment” input socket of an “EnVi Zone” node. The node

also contains an input socket for the connection of a schedule

node to set a absolute scheduled value for the specified heat

gain.

The options within this menu include:

◦ Type: Sets the type of equipment gain.

� None - no gains

� EquipmentLevel - sets the total Watts of internal gains for the zone.

� Watts/area - sets the internal gains in Watts per square metre of floor area.

� Watts/person - sets the Watts per occupant.

◦ Max level: Sets the maximum gain based on the previously selected gain type.

4.10.5 The EnVi Infiltration node

Figure 32: EnVi Infiltration node

The EnVi Infiltration node is available in the “Add - Zone Nodes”

menu in an “EnVi Network” node tree and sets a constant or sched-

uled level of fresh air infiltration into a zone. If an air-flow network

is specified this node, and the settings within it, will be ignored.

The node contains one “Infiltration” output socket for connection

to an “Infiltration” input socket of an “EnVi Zone” node, and one

input socket for the connection of a schedule node to specify a frac-

tional infiltration rate.

The node sets two options:

◦ Type - sets the type of infiltration

� None - no infiltration

� Flow/Zone - total flow for the whole zone in m3/s.

� Flow/Area - flow per square metre floor area in m3/s·m2.

� Flow/ExteriorArea- flow per square metre of exterior surface area in m3/s·m2.

� Flow/ExteriorWallArea - flow per square metre floor of exterior wall area in m3/s·m2.

� ACH - total flow in ACH.

◦ Level- sets the level for the previously selected infiltration type.

4.10.6 The EnVi Schedule node

The EnVi Schedule node can be found in the "Add" - "Schedule nodes" menu in the "EnVi Network" node tree.

A schedule node creates an EnergyPlus schedule, which is used to control an input’s time dependence e.g when

windows are open. All EnVi schedules basically operate over defined periods of a year, for defined days within that

period, and defined hours of those days. The node options reflect the specification of these three layers of time data.

The node is initially red and will only become the default colour when the options below are given valid values.
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Figure 33: EnVi Schedule node

These options are:

◦ "End day 1" - sets the end day of the first sched-

uled year period. This defaults to 365, the last

day of the year.

◦ "Fors" - sets the day types (valid day types are:

Alldays, Weekdays, Weekends, Monday, Tues-

day, Wednesday, Thursday, Friday, Saturday,

Sunday and AllOtherDays) for the above year

period in a space separated list. weekdays weekendswould for example set two day types for the next "Untils"

option.

◦ "Untils" - sets the schedule values with space separated end hour/value pairs, comma separated for each

period within a day type and semi-colon separated for each day type. 24:00 1; 08:00 0, 24:00 1 would, for

example, mean on the first day type (weekends) the schedule value is 1 up to midnight, and for the second

day type (weekdays) the schedule value is 0 up to 8am and the 1 until midnight. Awhole day period must be

covered so 24:00 should always be the last time specified.

If the first end day is less than 365 the three options above are repeated for the next year period. Up to four year

periods can be set.

For example, in figure 33 for the first period up to day 180, then for weekends in that period the schedule

is 1 all day, and for weekdays 0 until 8 in the morning and 1 for the rest of the day. For the next period from

day 180 to the end of the year (day 365) all days within this period have a schedule value of 0 until 05:00 in the

morning and then 1 until 24:00. The node presented in figure 33 represents a fraction schedule where the schedule

values are the fraction of a maximum value e.g. maximum occupancy where 0 would represent no occupancy, 1

maximum occupancy and 0.5 half the maximum occupancy. Sometimes however schedules specify actual values

e.g a changing thermostat set-point temperature. Refer to the EnergyPlus user manual for clarification of what

schedule type is required to control which parameter.

4.10.7 The EnVi Surface Flow node

Figure 34: EnVi Surface flow node

The "EnVi Surface flow" node creates a flow component within a

solid building construction such as a wall, floor or roof. It con-

tains two input sockets "Node 1" and "Node 2", and two output

sockets "Node 1" and "Node 2". Having sockets on both sides of

the node makes node connections within the node tree more flex-

ible but only one needs to be connected so if a node socket on one

side of the node is connected, the similarly named socket on the

other side of the node will disappear. All of these sockets are for

connection to the surface flow sockets of "EnVi Zone" nodes.

If both "Node 1" socket and "Node 2" sockets are connected to

two different EnVi zones the surface flow node is assumed to spe-

cify a flow component between the two zones. If only one socket is

connected to an EnVi zone node the surface flow is assumed to sit

on the external boundary of the zone and control airflow between

the zone and the outside air. If "Input" is selected for the "WPC

type" in the EnVi network control node, an "EnVi External" node

must then be connected to the other socket to represent outside con-

ditions.

Options in this node include:
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◦ Type - the type of flow component (effective leakage area (ELA) or crack)

◦ If “ELA” is chosen the next option sets the area of the leakage area. This maximum value for this option is

auto calculated from the area of the geometric face it is associated. Subsequent options control the parameters

of the leakage component type. Refer to the EnergyPlus input/output reference file for further details.

◦ If “Crack” is chosen the flow coefficient and flow exponent can be specified. Refer to the EnergyPlus in-

put/output reference file for further details.

4.10.8 The EnVi Sub-surface Flow node

The EnVi Sub-surface Flow node creates a flow component within an opening building construction such as a

window or door. It contains two input sockets "Node 1" and "Node 2", and two output sockets "Node 1" and "Node

2". All of these sockets are for connection to the sub-surface flow sockets of EnVi Zone nodes. If a node socket

on one side of the node is connected the similarly named socket on the other side of the node will disappear. This

makes node connections within the node tree more flexible. If both "Node 1" socket and "Node 2" socket are

connected to two different EnVi zones the subsurface flow is assumed to control airflow between the two zones. If

only one socket is connected to an EnVi zone node the surface flow is assumed to sit on the external boundary of

the zone and control airflow between inside and outside.

Figure 35: EnVi Sub-surface flow node

An additional socket is the "VASchedule" socket which

allows for the specification of a venting availability schedule

for the component.

The "Control type" option sets the criteria for the open-

ing and closing of the component. ’None’ means the win-

dows doors are always closed, ’Zone’means they open/close

according to the ventilation control of the parent ’EnVi

Zone’ node, “Constant” sets opening/closing according to

the schedule attached to the “VASchedule” socket and

"Temperature" sets opening/closing based on a temperature

thermostat schedule attached to the exposed “TSPSchedule”

socket.

Options in this node include:

◦ Type - the type of flow component (simple opening,

detailed opening, horizontal opening, effective leak-

age area or crack)

◦ Subsequent options control the parameters of the se-

lected component type. Refer to the EnergyPlus in-

put/output reference file for further details.

4.10.9 The EnVi External node

The “EnVi External” node can be added from the “Add >Airflow nodes” menu and provides wind pressure coeffi-

cients for the outside surfaces of the building. These nodes are only required if the "WPC type" option in the “EnVi

AFN” node is set to "Input". The node has sub-surface flow and a surface flow sockets as both inputs and outputs.

Joining these sockets to a flow component specifies the building wind pressure coefficients for the angles specified

by a “WPC Array” node. A “WPC Array” node is therefore required to be connected to the “EnVi AFN” Control

node for these nodes to be valid.

4.10.10 The EnVi Reference Crack Conditions node

This optional node sets the reference temperature, pressure and humidity for any ventilation cracks specified within

the network. If not created, EnVi will assume standard values for these parameters, which are the same as the default

values presented when this node is created.
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4.10.11 EnVi Program Node

Figure 36: EnVi Program node

Certain parameters within EnergyPlus can be con-

trolled with the Energy Management System (EMS)

control language, which offers more flexibility in con-

trolling the relationship between different elements of

themodel and the data it produces than the standard En-

ergyPlus input syntax. Details of the EMS syntax can

be found in the EnergyPlus EMS Applications docu-

ment. There is a single option within the node to select

the Blender text file that contains the EMS program lo-

gic. There are also two sockets: a ’Sensor’ socket that

can be connected 1 or more ’EMS Zone’ sensor sock-

ets, and an actuator socket that can be connected to 1 or more ’EMS Zone’ actuator sockets. It is the name of the

sockets in the connected EMS zones that defines the variable names to be used in the EMS program text. The

program text, written in the EnergyPlus Runtime Language (ERL) should be registered within Blender’ text editor

and can be selected with the “File:” menu within the node.

4.10.12 EMS Zone node

Figure 37: EMS Zone node

The ’EMS Zone’ node identifies the sensors and actu-

ators to be controlled by the EMS program node. Once

the name of an EnVi zone has been selected in the

“Zone” menu, options for the possible sensed and actu-

ated variable within the zone are presented. The sensed

variable might for example be the zone temperature or

occupancy level. The actuated variable might be the

temperature of the air supply or the opening factor of

any windows or doors (only opening factor is currently

supported). Once these have been selected the names

of the input sockets will reflect the names required to

address these variables in the EMS program text spe-

cified in the “EnVi Program” node.

4.10.13 The EnVi AFN node

Figure 38: EnVi AFN

The “EnVi AFN” node is created automatically within

the “EnVi Network” node tree during EnVi geometry

conversion if a Blender collection/EnergyPlus zone

contains air flow surfaces. The “EnViAFN” node then

specifies the high level options for the ventilation net-

work. For more details of these options refer to the En-

ergyPlus input/output reference document but options

the user may need to change include:

◦ Build type - sets whether the building is high rise

or low rise for wind pressure coefficient calcula-

tion purposes

◦ Azimuth - azimuth angle of the long axis of the

building for wind pressure coefficient calcula-

tion purposes

◦ Axis ratio - ratio of the long axis to the short axis

of the building for wind pressure coefficient cal-

culation purposes
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The node has one input socket, which allows for wind pressure coefficient azimuth angles to be specified rather

than automatically calculated by connecting an “EnVi WPC” node.

4.10.14 The EnVi WPC node

Figure 39: EnVi WPC

The “EnVi WPC” node attaches to the “EnVi AFN”

node via the AFN node’s "WPC Array" input socket

node and specifies the wind azimuth angles in degrees

from North that the wind pressure coefficient values

are specified for in the "EnVi External" nodes. The

example in figure 39 shows 8 angles clockwise from

north at a 45o intervals. “EnVi External” nodes at-

tached “EnVi Surface flow” and “EnVi Sub-surface

flow” nodes then specify the wind pressure coefficient

values for these angles for particular surfaces.

4.11 EnVi Material Nodes

Version 0.6 of the VI-Suite has moved to using nodes

to specify building constructions for EnergyPlus. This

allows the maximum number of EnergyPlus layers (10)

to be specified and allows shading elements to also be

simulated. For each Blender material that represents an

Energyplus construction the “Create EnVi Nodes” but-

ton must be pressed in the “VI-Suite Material” tab in

Blender’s material properties panel. When this button

is pressed a node tree is created in the ’EnVi Mater-

ial’ node editor with the name of the material. Material

node trees can be selected with the drop-down menu in the midlle of the header bar of the “EnVi Materials” The

node tree corresponding to the currently selected material should be displayed with a single “EnVi Construction”

node.

4.11.1 EnVi Construction node

Figure 40: EnVi Construction node

The “EnVi Construction” node is the fundamental

node for EnergyPlus construction specification and

can be used on its own to specify a construction

from the VI-Suite’s internal database, or in com-

bination with layer nodes to define bespoke lay-

ers. Although this node is created automatically

on the generation of an “EnVi Material” node tree,

additional construction nodes can be added via the

’Add - Type Node’ menu item in the node ed-

itor. A basic construction node is shown in fig-

ure 40. This node has one input socket called

“PV” for the specification of PV modules, and

an optional input socket called “Outer layer” if

a layer based construction specification is selec-

ted.

Options within this node include:

◦ Active - this construction node and and any linked layer nodes are the ones that define the EnergyPlus con-

struction. This allows the quick switching between different construction setups.
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◦ Type - this sets the class of construction type, which can be:

� Wall - opaque wall construction

� Floor - floor constructions that define the zone floor area

� Roof - roof constructions

� Window - openable transparent construction

� Door - openable opaque construction

� Shading - shading surface

� None - ignore this material

◦ Boundary - this sets the boundary on the other side of the construction, which can be:

� External - the conditions on the other side are ambient conditions

� Zone - the conditions on the other side is another zone’s conditions

� Thermal mass - if the type is wall, floor or roof conditions on the other side are ignored and the con-

struction is purely a source of thermal mass for the associated zone.

� Ground - if the type is floor then the external conditions are the ground conditions

◦ Airflow - this sets whether the surface allows air to flow through it as part of a ventilation network

◦ Specification - this defines how the construction is to be specified, options here are:

� Pre-set - takes the construction layers from the internal database

� Layers - uses nodes to define bespoke layers

If the pre-set specification is selected the node also presents the following options:

◦ The database entry selector for that construction type

◦ Alist of the layers included in that database entry with user specifiable thicknesses in mm (the mm in brackets

indicates the default thickness for that layer).

◦ Once a thickness has been changed a U-Value estimate is provided.

If the layers specification is chosen:

◦ AU-Value calculation button is shown to estimate U-Value based on the attached layer nodes.

◦ A text box is shown where a name can be entered to save the layer configuration to the internal database.

◦ If the custom construction name is not empty, and layer nodes are attached, a save button is presented to save

the construction.

◦ An input socket called “Outer layer” is exposed for the connection of layer nodes. As the name suggests

the layer node attached to this socket defines the outer construction layer. Additional layer nodes then work

inwards.

4.11.2 EnVi Layer nodes

“EnVi Layer” nodes are added via the ’Add - Layer node’ menu entry. Opaque, transparent and gas layers can be

added, the latter two primarily for window constructions (an example of an opaque node is shown in figure XXX).

These nodes are initially attached to the “Outer layer” node of the “EnVi Construction” node and subsequent layer

nodes can then be attached to the “Layer” input socket of the previous layer node.
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Figure 41: EnVi opaque layer node

Options with the opaque layer node are:

◦ Type - sets the type of material.

◦ Class - sets whether the the material properties

are pulled from the internal database or defined

with custom properties.

If the specification is “Database” the following options

are presented:

◦ Material - the database material.

◦ Thickness - in mm.

If the specification is “Custom” the following options

are presented:

◦ Name - sets the name of the custom material

◦ Thermophysical parameters - entries for the ther-

mophysical parameters required by EnergyPlus

( see the EnergyPlus InputOutput Reference

manual for further details of these)

◦ Layer Save - if a custom name has been specified

a save button is presented to save the material to

the internal database.

The “EnVi transparent layer” node is similar to to the opaque node but has options purely for glass materials. The

“EnVi gas layer” node does the same for window gas layers (gas layers cannot currently be saved to the internal

database).

4.11.3 EnVi PV node

EnVi can now model the power output from PV panels. The simple, one-diode and Sandia representations of PV

characteristics are all supported. PVs are specified with the “EnVi PV” node which can be added via the “Add -

PVNode - PV” menu entry. Once created it should be attached to the “PV” input socket of an “EnVi Construction”

node.

Options within this node include:

◦ Area calc - a button to calculate the total face area to which this material is applied

◦ Heat transfer - sets the thermal relationship between the panel and any construction with which it is associated

(see EnergyPlus InputOutput reference manual for more details).

◦ Type - Simple, One-diode and Sandia PV power algorithms (see EnergyPlus InputOutput reference manual

for more details).

◦ If the simple type is selected options are:

� Proportion of the surface areas covered with actual PV cells.

� The conversion efficiency of the PV cells.

◦ If the One-diode type is chosen:

� Model - the database PV module model can be selected here or a custom module saved by specifying

the relevant parameters (see EnergyPlus InputOutput reference manual for more details).

◦ If the Sandia type is chosen then simple set the PV module model.

PV installations can either be incorporated into wall and roof constructions, or they can be stand-alone. For the

latter case the PV material is applied to a shading material.
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4.11.4 EnVi PV Generator node

An “EnVi PV Generator” node is required to take the power from PV modules and make them available to the

building as standard AC voltage by the use of an inverter. This node plugs into the “PV Generator” input socket of

a “PV” node. At this time only a simple inverter model is implemented and so options here are:

◦ Efficiency - percentage efficiency of the inverter in converting DC from the PV panels to AC.

◦ Radiative fraction - the proportion of the power loss in conversion that is emitted as infrared radiation by the

inverter unit.

4.11.5 EnVi PV Schedule node

The “PV Schedule” node can be used to control when and in what proportion the PV panels and/or PV generator

produces power. If no node is specified it is assumed the PV system can produce power at any time. The schedule

node presents options in a similar manner to a general “EnVi Schedule” node with 0 as off, 1 as on or a value in

between for a proportion.

4.11.6 Copying materials

If you want to copy an existing EnVi material to change some of its properties, a particular process should be

followed. Create a new material slot for the object you wish to have the copied material. Select in this slot the

material you want to copy. Press the button immediately to the right on the material name window, which will

usually have a number displayed within it. This will create a copy of the material. Rename this material how you

wish and then recreate the material node tree by hitting the ’Create EnVi Nodes’ button in the ’VI-Suite Material’

tab of the material.

4.11.7 Saving materials and constructions

Saving EnVi constructions or materials to the internal database alters the Construction_database.json and Mater-

ial_database.json files in the “Add-on directory > EPFiles” folder. If updating the VI-Suite from github or replacing

the add-on folder, any changes made to these two files will be lost so make sure a backup copies are made that can

be used to replace the newer files.
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4.12 FloVi Nodes

FloVi nodes control the elements of a CFD simulation with OpenFOAM.

4.12.1 FloVi Case node

Figure 42: FloVi Case node

The “FloVi Case” node can be added with the “Add > Process

nodes” menu and creates the directory structure and some of the

high-level files required for an OpenFOAM simulation. The dir-

ectory structure is created within the “Openfoam” directory in the

project directory. This directory is known, in OpenFOAM terms,

as the case folder, which means OpenFOAM binaries run from

within this folder will find all the information about the simula-

tion from within the folder.

The node contains one “Case out” socket for connection to a

“FloVi Netgen” “Case in” socket.

The node contains the following context sensitive options:

◦ Transience - this menu sets whether the simulation is steady-

state or a time based transient model (only steady-state is

currently functional).

◦ Turbulence - if transience is steady-state this menu sets the

turbulence model for the simulation:

� laminar, no turbulence

� k-Epsilon, k-Epsilon turbulence model

� k-Omega, k-Omega turbulence model

� Spalart-Allmaras, Spalart-Allmaras turbulence model

◦ Time step - the false time step for a steady-state simulation

(seconds)

◦ End time - the end false time for a steady-state simulation

(seconds)

◦ Velocity val - the initial domain velocity value (m/s)

◦ Buoyancy - whether heat transfer is to be modelled

◦ Buossinesq - whether the Buossinesq approximation should be used for heat transfer.

◦ Pressure abs - the initial absolute pressure value within the domain

◦ Pressure rel - the relative initial pressure of the domain

◦ p_rgh value - the initial dynamic relative pressure within the domain

◦ k value - the initial value of turbulent kinetic energy within the domain

◦ Epsilon value - the initial value of turbulent kinetic energy dissipation within the domain

◦ Omega value - the initial value of the rate of turbulent kinetic energy dissipation within the domain

◦ Nut value - the initial value of turbulent viscosity within the domain

◦ T value - initial temperature within the domain (K)
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◦ Radiation - whether radiation is to be considered within the model

◦ Rad model - the model of radiation to be used

◦ G value - initial radiation intensity within the domain

◦ Solar - whether solar radiation is to be calculated

◦ Sun - selects the Blender light to act as a solar source

◦ p Residual - sets the pressure error residual below which the simulation is considered to have converged

◦ U residual - sets the velocity error residual below which the simulation is considered to have converged

◦ k/e/o residual - sets the error residual below which the simulation is considered to have converged for the k,

Epsilon and Omega parameters.

4.12.2 FloVi Netgen node

Figure 43: FloVi Netgen node

The “FloVi Netgen” node can be added with the

“Add > Process nodes” menu and controls com-

putational mesh generation with Netgen (https://ng-

solve.org/). Netgen produces tetrahedral meshes which

can be converted in polyhedral meshes with Open-

FOAM. This node has one input socket “Case in”

for connection to a “FloVi Case” “case out” socket

and one output socket “Mesh out” for connection

to a “FloVi Boundary” “Mesh in” socket. Upon

pressing “Generate” the mesh will be constructed

and, all being well, a visualising mesh will be cre-

ated in Blender in the “FloVi Geometry” collec-

tion.

Options within this node include:

◦ Cell size - this sets the maximum cell size for the

overall domain

◦ Position corr - this sets the maximum distance

difference for a Blender face material to be asso-

ciated with a computational mesh face (this may

need to be lowered if dealing with a very small domain)

◦ Angular corr - this sets the maximum angular difference for a Blender face material to be associated with a

computational mesh face

◦ Distinction angle - this sets the angle between geometry faces that will force Netgen to consider the separating

edge a mesh boundary

◦ Inflation - controls the rate at which smaller localised cells take on the size of the domain (smaller value leads

to a more gradual cell size change)

◦ Optimisations - controls the number of optimisations steps for the meshing algorithm

◦ Polygonal - controls whether OpenFOAM should be used to generate a polygonal mesh
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4.12.3 FloVi Boundary node

Figure 44: FloVi Boundary node

Thie “FloVi Boundary” node can be added with the

“Add > Process nodes” menu and takes the FloVi

boundary parameters set within Blender’s Material

properties panel and writes out the requisite Open-

FOAM boundary specifications. The node contains

one input “Mesh in” socket for connection to the “Mesh

out” socket of a “FloVi Netgen” node, and one output

“Context out” socket for connection to the “Context in”

socket of a “FloVi Simulation” node. Upon pressing

the “Generate” button boundary specifications will be

written to the case directory.

The only option here is:

◦ Paraview - opens Paraview to visualise the mesh once the boundaries have been generated.

4.12.4 FloVi Simulation node

Figure 45: FloVi Simulation node

The “FloVi Simulation” node can be added with the

“Add > Simulation nodes” menu and runs the Open-

FOAM simulation. The node contains one input “Con-

text in” socket for connection to a “FloVi Bound-

ary” “Context out” socket, and one output “Res-

ults out” socket for connection to a “VI Metrics”

or “VI CSV” node. Probes will need to be set-

up within the flow domain for results to be avail-

able.

Options here are:

◦ Processes - splits the mesh into a number of

chunks set here for parallel computation

◦ Paraview - opens Paraview for results visualisa-

tion
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5 Using the VI-Suite

5.1 Sun Path Projection

Figure 46: Sun Path node set-up

Projecting a sun-path analysis into the Blender scene

requires a “VI Location” node to be created to

provide the latitude and longitude co-ordinates of

the scene. The “VI Location” node can either take

the latitude and longitude values from an EPW file,

or they can be entered manually. Once the location

node has been set-up a “VI Sun Path” node can be

created and the "Location out" socket of the location

node dragged to the "Location in" socket of the “VI Sun Path” node. A typical node set-up is shown in figure 46.

The Sun Path node itself has one menu option to set the number of suns created, and a button to be clicked to

create the sun-path. The created sun path with have a Blender object base and Blender lights to represent the suns

along with OpenGL overlays of the sun paths. The entire sun path references the base, which as a regular Blender

object (called spathMesh) can be rotated, scaled and moved, and doing this will manipulate the entire sun path. The

sun path base object spathMesh has materials associated with it and these can be changed to alter the appearance

of the sun path. Once a sun-path has been created a number of options are presented with the 3D view port sidebar

in the "VI-Suite Display" tab (section 4.5.3). The sun path display options available are shown in figure 47.

Figure 47: Sun Path visualisation options

The options in this panel are:

◦ Lighting - sets the way Blender’s solid view mode is lit. Flat

is recommended for sun path shadowing (solid mode shad-

owing is turned on in the solid mode shading menu).

◦ Latitude - allows the changing of the latitude location for the

sun path

◦ Longitude - allows the changing of the longitude location for

the sun path

◦ Day of year - if a single or hourly sun set has been created

this option sets the day of the year for the sun position(s)

◦ Time of day - if a single or monthly sun set has been created

this option sets the time of day for the sun position(s)

◦ Sun strength - in solid shading mode, if shadows are turned

on, this options sets the depth of the shadows. If in Cycles

rendered mode this sets the strength of the sun(s). This op-

tion is useful to get the right level of shadows.

◦ Sun angle - in Cycles rendered mode this sets the sharpness

of the shadows.

◦ Line width - sets the width of the sun path lines (does not

work on OS X).

◦ Solstice colour - sets the colour of the solstice lines.

◦ Hour main colour - sets the main colour fr the hour lines.

◦ Hour dash colour - sets the dash colour of the hour lines.

◦ Hour dash ratio - sets the size of the hour line dashes.

◦ Hour dash density - sets the ratio of dash to hour line.
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◦ Sun size - sets the size of the OpenGL sun overlay.

◦ Sun colour - sets the colour of the OpenGL sun overlay.

◦ Globe colour - sets the colour of the sun path sphere.

◦ Display time - displays the date, time, solar azimuth and altitude next to the sun if a single sun has been

created.

◦ Display hours - displays the time in hours at the top and bottom of the hour lines.

◦ Font size - size of the font of any numerical/text display.

◦ Font colour - main font colour.

◦ Font shadow - turns on font shadowing.

◦ Shadow colour - changes the colour of the font shadow colour.

◦ Display active - turn this off to deactivate visualisation (this should be turned off when finished with the

visualisation).

For the sun path analysis the choice of suns requires certain rendering modes for optimal operation. If a single sun

is chosen then shadowing analysis can be achieved with the solid viewpoint rendering mode. If multiple suns are

selected then shadowing can only be visualised in view port rendering mode, preferably with the Cycles rendering

engine. In rendered mode, parameters such as sun strength and sky colour are important to achieve the right balance

of light and shadow. It might also be necessary to modify the colour management of the screen rendered view port

in the “Render Properties > Color Management”.

5.2 Wind Rose Projection

Projecting a wind rose into the scene requires a “VI Location” node and a “VIWind Rose” node, that latter of which

can be added with the “Add > Analysis Nodes” menu.

Figure 48: Wind Rose node set-up

In this case the location node provides wind speed

and direction data for the wind rose analysis and there-

fore an EPW file must be chosen as the source of in-

formation within the location node. A typical node set-

up is shown in figure 48.

The options within the wind rose node control the

type of wind rose plot to create (two types of histogram

and three types of contour plot are available), the start

and end days of the year to plot and the colour scale to

use for the plot. Examples of a histogram and contour

plot are shown in figure 49.

Figure 49: Histogram and contour wind roses

Once the button to create a wind rose is pressed a

wind rose object is created at the centre of the scene.

This object, like any Blender object, can be moved,

scaled and re-sized as desired. Each time the wind rose

button is pressed a new object is created.

When a wind rose object has been created a button

is exposed in the "VI-Suite Display" tab (section 4.5.3)

of the 3D view properties panel. Thewind rose analysis

uses the new VI-Suite display framework so once this

button is pressed 3 icons will appear in the 3D view: A

"Legend" icon to display the wind speed colouration of

the wind rose, a “Table” icon to display tabulated wind
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speed and direction data and a “Scatter icon” to display

a scatter graph of the hourly wind speed or direction data. The data displayed in the table and scatter graph is

extracted from the currently selected wind rose object.

Figure 50: Wind metric display options

Some display options are also presented in the 3D

view properties panel figure 50). These include:

◦ Windmetric - defines whether wind speed or dir-

ection is plotted in the scatter graph

◦ Colour - defines the colour of the scatter graph.

◦ Max - defines the max value of the scatter graph:

can be either be the max value from the data or

user specified.

◦ Min - defines the min value of the scatter graph:

can be either be the min value from the data or

user specified.

◦ Display active - this should be turned off when

wind metric display is no longer needed.

5.3 Shadow Mapping

Figure 51: Shadow Map node set-up

A shadow map study requires a VI Location node to

provide latitude and longitude co-ordinates, and a “VI

Shadow Map” node. so either an EPW file or manual

entry can supply this data. A typical node set-up is

shown in figure 51.

Ashadow study analysis requires sensing geometry

to be specified. This geometry is specified via its ma-

terial designation. Once a Blender object has a material

associated with it (and this material can only be asso-

ciated with specific faces of an object if desired) then

in the Blender material properties panel in "Vi-Suite

Material" tab there is an drop-down menu called "Ma-

terial type". Within this menu the option "Light sensor"

should be selected. It should be noted that sensor geo-

metry senses in the direction of the normals of the geo-

metry. You can check normal direction in Blender’s

mesh edit mode. If normals point in the wrong direc-

tion “flip” the normals, or rotate the object so they face in the desired direction.

The year period for the simulation is set within the “VI ShadowMap” node with the start month and end month

options. The period of each day to be simulated is set with the start hour and end hour options. The "Interval"

option sets the hourly time step for the simulation. A value of 1 will do a calculation once per hour, and a value

of 0.25 will do one every 15 minutes. The "Animation" option allows either a static analysis or one based on a

geometry animation. If "Static" is selected then results are valid for the current selected frame. If "Animated" is

selected results will be generated for each frame of the created animation.

In the 3D view port sidebar (section 4.5.3) the "VI-Suite Display" tab will present a shadow study display button

and once this is pressed will then plot on the sensing geometry a user defined colouration, signifying how often that

point receives direct sunlight, when the sun is above the horizon, for the specified simulation period. The display

panel options are shown in figure 52.In the 3D viewport an icon will be displayed in the upper left corner. Clicking

on this will open up a legend display relating colour to numerical value.
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Figure 52: Shadow study display options

The options in the display panel are:

◦ VI 3D Display - If selected before the display button

is pressed the results can be extruded to provide 3D

result visualisation.

◦ Shadow Display button - When clicked will initiate

display and expose further display options.

◦ Result type - sets the metric (% sunlit is the only rel-

evant metric here)

◦ Legend unit - a string entry box to replace the legend

unit title

◦ Processing - modifies the results or their visualisation

� None - no modification

� Modifier - a constant result modifier

� Script - a Python scripted result and/or visualisa-

tion modifier

◦ Modifier - if modifier was selected in the previous op-

tion this string entry box can scale modify the results

(*100 would multiply results by 100, /100 would di-

vide by 100)

◦ Script - If script was chosen as the processing option

than a selection box is presented to pick a Blender text

file containing the python script.

◦ Frame - Either shows the frame that a static analysis was conducted on, or allows the picking of the frame of

a parametric analysis

◦ Legend max - allows the changing on the max value of the legend scale.

◦ Legend min - allows the changing of the min value of the legend scale.

◦ Legend scale - sets the legend scale to linear or logarithmic.

◦ Legend colour - sets the colour of the legend and geometry colouration.

◦ Legend levels - sets the number of colour divisions of the legend and geometry colouration.

◦ Emitter materials - makes the Blender materials ignore any 3D view port lighting (useful for Cycles rendered

mode).

◦ Emitter strength - emission strength of emitter materials

◦ Draw wire - draws a wireframe over the selected result visualisation geometry

◦ 3D Level - If “VI 3D Display” was selected this number will extrude the results plane for 3D results visual-

isation.

◦ Transparency - sets the transparency of the result geometry

In the Point Visualisation section:
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◦ Enable - Turns on per-point numerical visualisation of the results

◦ Selected only - Only the currently selected object will display numerical results

◦ Visible only - Only points not obscured in the 3D view show numerical results

◦ Font size, font colour, font shadow - changes the colour and size of the point numeric font.

The node contains one output “Results out” socket which can connect to a “VI Chart” or “VI CSV” node for data

visualisation/export. Figure 53 shows a shadow study analysis of the terrain around Mount Snowdon.

Figure 53: Shadow study analysis of Mount Snowdon

5.4 Sky View Factor

A sky view factor (SVF) analysis requires only a “VI SVF” node available in the “Add > Analysis Nodes” menu.

The node is described in section 16. The process of setting up the simulation is very similar to the shadow mapping

process in that Blender geometry with a “Light Sensor” material associated with it will act as the sensing geometry

according to the sub-divisions of the geometry. Once the “Sky View Factor” button in the “VI SVF” node has been

pressed the calculation will proceed and when finished a “Sky View Display” button will appear in the “VI-Suite”

tab of the 3D viewport sidebar. Pressing this will create visualisation geometry in the “LiVi Results” collection and

present options similar to those described in the shadow mapping section(5.3). The “Results out” socket of the “VI

SVF” node can be connected to the “VI CSV” or “VI Chart” node for export/visualisation.

5.5 LiVi Lighting Analysis

Lighting analysis is conducted with the LiVi component of the VI-Suite, which acts as a pre/post processor for the

Radiance software simulation suite. Avalid Radiance installation is therefore required on the host machine. Details

of the installation process can be found in section 2.

The main LiVi nodes are: “LiVi Geometry”, “LiVi Context”, “LiVi Simulation”, “LiVi Image”, “LiVi Glare”

and “LiVi FC”. All are detailed in section 4.8. A basic LiVi analysis will require “LiVi Geometry”, “LiVi Context”

and “LiVi Simulation”.

A numerical LiVi lighting analysis, like a shadow study, requires geometry within the scene to be identified as

sensing geometry. This is done in the material panel within the "Vi-Suite Material" section where the option "Light

Sensor" should be selected in the "Material type" drop-down list. All geometry to which this material is associated

will now act as a sensing plane. Sensing surfaces are not required for glare studies, or if only a preview of the

Radiance scene is to be conducted. The sensing geometry senses in the direction of the Blender sensing face or

vertex normals.
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5.5.1 LiVi Geometry

The LiVi Geometry node, which can be found in the "Add > Process Nodes" menu of the Vi-Suite node editor,

controls the export of the of the Blender scene geometry and materiality to the Radiance text file format. Any

Blender geometry that is not hidden, and has at least one material associated with it, will be exported.

Upon pressing the node’s "Export" button the node first converts Blender materials to Radiance material de-

scriptions. Specification of the Radiance material type for a particular Blender material is done within Blender’s

material properties panel. Within this panel is a section called "VI Material Type". If “Material type” menu in

this section is set to “Geometry” then a drop down menu called "LiVi Radiance type" is presented that allows the

designation of the Radiance material type for the selected Blender material. Options include "Plastic", "Metal",

Glass" etc. Options to further specify the Radiance material are then presented. If a material that allows light to pass

through it: glass, dielectric, translucent or anti-matter is chosen an option is presented to designate the material as

a photon port. Setting this option for surfaces through which all light will reach the sensor surfaces e.g. windows,

speeds up simulation if using Radiance’s photon mapping capability.

Next, suitable geometry is exported. If the ’Fallback’ option in the LiVi Geometry node is not selected then obj

files are saved to the "obj" folder created in the project directory and automatically converted to Radiance mesh

files, with Radiance’s obj2mesh program, and referenced within the Radiance input text unless the material has the

a "Mirror" or an "Emission" material associated with it as Radiance meshes cannot have these materials attached.

In that case, or if the “Fallback” options is selected, actual object vertex co-ordinates are instead written out to the

Radiance input. Non-manifold Blender geometry also defaults to vertex position export.

Radiance instances can also be created if particles have been applied to an object that link to an instance object.

Refer to Blender documentation for further details of this.

Next Blender lights are exported to Radiance format. There are two ways to set-up lights for Radiance export:

creating standard Blender lamps, or creating a plane at each face of which a lamp is automatically specified by

giving the mesh the “Light Array” type in the "VI-Suite Object Definition" section. If using the first method then

selecting a lamp within Blender will display in the "VI-Suite Object Definition" section and some IES specific

options. In this section it is possible to specify an IES file to associate with the Blender lamp. IES files are released

by luminaire and lamp manufacturers, and describe the brightness of a luminaire or lamp from multiple directions.

The desired IES can be picked with the "Select IES File" button. Some additional options are also presented:

◦ IES Dimension - specifies the distance unit for the geometry described in the file

◦ IES Strength - which allows the light to be dimmed (can be animated)

◦ IES Colour - sets the colour of the lamp (can also be animated).

� RGB - sets the RGB colour of the lamp

� Temperature - sets the colour temperature of the lamp

The second method allows any selected mesh object to have an IES file associated with it via the "VI-Suite Object

Definition" section of the "Object data" panel. Any IES file selected here will now be applied in the Radiance scene

at each face centre of the mesh object. This is useful for quickly setting up arrays of lights. Simple rotations of

the light array object will be reflected in the positioning and direction of the lights in the Radiance scene, although

more complex rotations may not be correctly reported to Radiance. In general keep IES object rotations to a single

axis rotation.

If undertaking an animated, parametric analysis LiVi will export a Radiance scene for each frame from start

frame to end frame as specified within the geometry node interface. How to set up animations in Blender is beyond

the scope of this document so please refer to on-line information for this but in short pressing the ’i’ key with the

cursor over the value in the interface to be animated will register that value for the current animation frame selected.

Radiance Patterns & Textures For certain Radiance material types there is also a “Textured” option available

in the VI-Suite Material” section. This allows the application of an image to the geometry which will be converted

into a Radiance pattern. To apply the Radiance pattern “Fallback” must be turned off the in the “LiVi Geometry”

node and the Blender material should be ’Diffuse BSDF’ and the “Color” of this material should be set to an image

texture and the image selected to provide the colour. The image will also have to be UV Mapped to the Blender

geometry in Blender’s “UV Editor” to provide the positional relationship between the image and the geometry.
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Figure 54: Shader node setup for Radiance patterns & textures

Radiance textures can be applied based the image selected above by selecting the “Normal map” option in the

“VI-Suite Material” section. A normal map image version of the above image is required and a normal map turned

on for the material in Blender. This is maybe easiest by specifying the node arrangement in Blender’s “Shader

Editor” window for the material with the node arrangement shown in figure 54. Texture normal maps only work

for planar surfaces. Additional options also exposed for the directions in Blender world co-ordinates of the colours

within the normal map image when applied to the planar surface in Blender. In addition, the strength of the normal

map perturbation of Radiance normals can be set with the “Normal Map” node strength (figure 54).

Radiance BSDFs It is possible to generate BSDFs with Radiance for use with simulation in the VI-Suite. BSDFs

are useful when considering the repeating arrays of geometry that constitute a complex fenestration system (CFS)

and a BSDF can be generated for one element of the repeating array.

To generate a BSDF a Blender object is required that represents the geometry for which a BSDF is to be

calculated. This object should have Radiance material properties associated with it assigned, and the object itself

should be identified as “Complex Fenestration” in the Blender object properties panel in the “VI-Suite Object

Definition” section. The size and position of the object does not matter as the VI-Suite does not currently support

the inclusion of geometry into the BSDF, and the VI-Suite automatically moves and rotates the geometry to be

suitable for BSDF generation. Other rules on generating BSDFs with Radiance should however still be respected

(see the genBSDF manual for details)

The object requires one mesh face that has the BSDF Radiance material specification. This face is not part of

the BSDF calculation itself, and can be created by copying an existing mesh face of the object, but it does serve

two other functions: it is the material within which the BSDF data will be stored, and the normal of the face must

point into the room or towards the camera ray direction. The face should also be positioned inline with the internal

face of the object.

Options for the BSDF material applied include:

◦ Proxy depth - not used during BSDF generation but important for the application of the BSDF material in a

simulation.

◦ Up vector - this sets the up direction for the BSDF during generation and application

◦ Load/Delete/Save BSDF - hopefully self-explanatory
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Once the setting for the BSDF material are as required then the in the Blender object properties panel the object

has been set to “Complex Fenestration” more options should appear for actual BSDF generation. These include:

◦ Direction - sets the direction for the sample rays: backwards, forwards or bi-directional

◦ Klems/Tensor - whether a Klems or Tensor Tree BSDF should be generated

◦ Samples - number of samples per direction

◦ RC params - text box for custom rcontrib parameters

Figure 55: Example BSDF visualisation

Once these settings are as desired the “Generate

BSDF” button can be clicked and the BSDFwill be cre-

ated. AKivy windowwill pop up although this window

cannot give a prediction of time remaining for BSDF

calculations. Pressing the “Cancel” button will kill

BSDF generation if the Python psutil package is avail-

able. If not, rcontrib processes must be killedmanually.

Bear in mind that BSDF generation with high sample

numbers can take a long time.

Once completed, the BSDF information is stored

within the Blender material, and can now be applied to

Blender geometry for simulation. Any geometry that is

to have the BSDF applied must have it’s normal also

pointing inwards, or towards the camera ray direction.

The “ProxyDepth” of thematerial can now be used.

If the proxy depth is zero, all incoming light will be pro-

cessed via the BSDF. If the proxy depth is more than

zero any valid Radiance geometry within that depth

will deal with direct light calculation and the BSDF

with diffuse. This can be done using Blender instances

for memory efficiency. If no geometry is specified dir-

ect light will pass straight through the BSDF. The “Up

Vector” should also be set to the up direction of the geo-

metry to which the BSDF material is applied.

If a KlemsBSDF has been generated, the BSDF can

be visualised with the VI-Suite. Selecting the original

complex fenestration object, and selecting the BSDF

material within that object, should display a “BSDF

Display” button in the “VI Display” section of the “VI-

Suite” tab in the 3D view port sidebar. Clicking this button will create an icon in the upper left of the 3D view port.

Clicking on this will display two Klems distributions: the upper one can be clicked on to select the incoming light

direction and the bottom one displays the outgoing light percentage distribution. Options are also displayed in the

VI-Suite display tab that include:

◦ Direction - sets the direction for visualisation

◦ BSDF max/min - sets the legend maximum and minimum values

◦ BSDF scale - linear or logarithmic legend scale

◦ BSDF colour - sets the legend and BSDF colouration

◦ Display active - this should be turned off after visualisation
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5.5.2 LiVi Basic analysis

A basic analysis allows for the prediction of illuminance (lux), irradiance (W/m2) and Daylight Factor (%). A

typical node set-up is shown in figure 56.

A "VI Location" (section 4.6.1) node, "LiVi Geometry" (section 4.8.1) node, "LiVi Context" 4.8.2) node and

a "LiVi Simulation" (section 4.8.3) node are required for this type of analysis and the node connections should

replicate the connections shown in figure 56. A basic LiVi analysis can be selected in the first menu of the context

node.

Figure 56: Typical LiVi Basic node set-up

In addition to these nodes, sensing geometry is re-

quired for the calculation. If no sensing geometry

is present on the “Preview” button will appear in the

“LiVi Simulation” node. This sensing geometry is set

by associating a “Light Sensor” material in the “Mater-

ial type” menu to the desired geometry in the material

properties panel of Blender within the “VI-Suite Ma-

terial” section.

Once all nodes have been exported, connected, and

the "Calculate" button has been pressed on the simula-

tion node the Radiance simulation is run. A Kivy win-

dow should then appear giving an estimate of simula-

tion time and presenting a button to cancel the simula-

tion. When completed the Radiance results are stored

within the meshes of the sensing geometry for visual-

isation. After simulation options in the "VI Display"

panel detailed in section 5.5.7 control visualisation of

these results. The options within this panel are similar

to the ones available for shadow mapping.

5.5.3 LiVi CBDM

A Climate Based Daylight Modelling (CBDM) analysis requires the same node setup as a basic LiVi analysis but

with the first option of the “LiVi Context” node set to “CBDM”. Some CBDM specific options are then revealed

in the context node (section 4.8.2). A CBDM analysis allows the lighting performance of a building over longer

periods of time to be analysed and calculates metrics such as daylight availability, annual sunlight exposure and

useful daylight illuminance. The other difference is that an EPW file must be specified as the source of location

information in the “VI Location” node as the information for the environmental lighting conditions is provided (at

least initially) by this EPW file.

When the simulation node’s calculate button has been pressed the Radiance simulation is initialised a kivy

window will appear and the Blender interface will lock up until completion. If an hourly calculation metric has

been selected the simulation can take some time. Once completed, display options will again appear in the “VI

Display” tab and detailed in section 5.5.7. If hourly data has been generated the “VI Chart” node and the “VI CSV”

node should be used for visualisation and further processing respectively.

5.5.4 LiVi Image creation

Radiance images can be generated with LiVi for more contextual illuminance/brightness calculations and glare

analysis. To create a Radiance image the “LiVi Geometry” and “LiVi Context” nodes connect into a “LiVi Image”

(section 4.8.4) node instead of a “LiVi Simulation” node.

Once the desired options have been set in the “LiVi Image” node then pressing the “Image” button will begin

the calculation of the image and bring up a Kivy window to show progress. As the simulation runs the image will

be updated and stored to the “liviimage” image in Blender’s image editor. It should be noted that the generation of

high accuracy Radiance images can take a long time.

Especially when simulating exterior scenes, the image produced can be over-exposed and appear too white in

Blender. In this case the “Compositor” window in Blender can be used to tonemep the image.
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Once the simulation is finished then the images are saved to the images folder in the project directory with

name(s) base_name-frame.hdr where base_name is set in the image node and frame is the frame(s) over which the

images are generated.

5.5.5 LiVi Glare analysis

Glare analysis is achieved with the “LiVi Glare” node, and uses the evalglare functionality of Radiance. Glare

analysis requires a fisheye Radiance image of a scene, and this image can be provided by the “LiVi Image” node.

To generate this image the fisheye option should be selected in the image node, 180o should be set as the field-

of-view (fov) and image pixels should be set to 800x800. Larger images can be processed but it takes a long

time. Once the image has been generated the image node can be plugged into the “LiVi Glare” node. Once this

node has been connected then appropriate options can be selected in the glare node (section 4.8.5) and the “Glare”

button pressed, a glare analysis image will be saved in the “images” folder of the project directory with the name

base_name-frame.hdr where base_name is set within the node, and frame is the frame the image is generated for.

5.5.6 LiVi False Colour

A LiVi image can be processed with a false colour filter to associate colours and a legend with the numerical data

embedded within the image. A false colour image is produced by connecting a “LiVi Image” node to a “LiVi False

Colour” node (section 4.8.6). Once options in the “LiVi False Colour” are set as desired then pressing the “Process”

button will create a false colour image in the “images” folder of the project directory. The name of this file will be

base_name-frame.hdr where base_name is set within the node, and frame is the frame of the simulation the original

image is associated with.

5.5.7 LiVi Display

After a LiVi simulation display options are presented within the "VI Display" section of the “VI-Suite” tab of

Blender’s viewport sidebar (toggled with the "n" key over the 3D display). A basic, LiVi specific “VI Display"

section is shown in figure 57 along with the Blender viewport and result/legend display.

Figure 57: LiVi Display options

Initially after simulation only the "VI 3D display" toggle switch and the "Radiance Display" button are shown.

The "VI 3D display" toggle controls whether a 3D display of the results metric is desired. Once the "Radiance
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Display" button is pressed new Blender objects will be created in the “LiVi Results” collection and coloured ac-

cording to the Radiance results, icons to display data graphics will appear in the 3D view and further options are

presented. If the colouration of the results geometry cannot be seen, and you are in Blender’s solid display mode,

you need to select material colour in the solid mode shading menu at the top of the 3D viewport. The options

presented include:

◦ Result type - sets the metric for display. Choices here will depend on the kind of analysis that has been

conducted.

◦ Legend unit - string entry to replace the legend title unit.

◦ Processing - menu entry to define any modifiers to be applied to the results.

� Modifier - uses the following string entry to modify the results

* string entry to act as a result modifier (*100 would multiply results by 100, /100 would divide by

100).

* this option in combination with the legend unit option can be used to display results that are not

embedded in the result geometry e.g. daylight factor (%) can be extracted from lux values by

placing *0.01 here (assuming a daylight factor sky has been simulated). Visible irradiance (W/m2)

can be extracted from lux by placing /179 here.

� Script - uses a script to modify the results

* File - Blender text editor script for custom result modification

◦ Frame - frame selection to visualise a step in an animated/parametric simulation

◦ Legend max/min - controls the range of the displayed legend and the associated sensor mesh colours in the

3D view.

◦ Legend scale - legend and result display can be set to linear or logarithmic.

◦ Legend colour - sets the colour map for the legend and mesh sensors.

◦ Legend levels - sets the number of legend and mesh colouration sub-divisions.

◦ Emitter materials - set the result colour materials to emitters (ignores shading in rendered mode)

◦ Emitter strength - sets the brightness of the emitter materials

◦ Draw wire - toggles the display of a wire-frame for the selected object. May need to be selected twice to turn

on the wire-frame.

◦ 3D Level (only appears if VI 3D display option was chosen) - controls the level of 3D extrusion of the results

geometry

◦ Transparency - set the transparency level of the result geometry

The next section controls the display of numerical result values for each point of the sensing geometry. Options in

this section include:

◦ Enable - toggles numeric display

◦ Selected only - display numerical results only on the selected geometry

◦ Visible only - only the sensing geometry points visible within the 3D view display numerical values (orient-

ating the view to the selected object may be required to correctly calculate which points are visible)

◦ Font size, colour, shadow controls the number display

◦ Position offset - controls the offset point for the numerical display (in general should be set to the same value

as the offset value in the "LiVi Geometry" node

The "Display active" option at the bottom turns off result display. This should be turned off when results display is

no longer required.
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5.6 EnVi Energy Analysis

Figure 58: Typical EnVi node set-up

The EnVi component of theVI-Suite is a pre/post processor for the EnergyPlus simulation engine (http://apps1.eere.en-

ergy.gov/buildings/energyplus/). An EnVi analysis requires a "VI Location" node to provide an EnergyPlus weather

file for the simulation, an EnVi Geometry node to pre-process the full Blender geometry into the sub-set of the geo-

metry that will be used in the EnergyPlus simulation, an EnVi Export node to convert the sub-set of the Blender

geometry and the building context to the EnergyPlus text format, and finally an EnVi Simulation node to run the

simulation. Optionally, a VI-Suite chart node can be used to plot out the simulation results. A typical node layout

is shown in figure 58.

Figure 59: EnVi Collections

A new feature in Blender 2.8 and above is collec-

tions, which replace the old layer system. EnVi uses

this collection infrastructure to both organise the geo-

metry to be processed and exported. This means that

Blender objects that define EneryPlus thermal zones

must now be placed into collections - one collection per

thermal zone - and these collections must reside within

the upper level “SceneCollection”. The example in fig-

ure 59 shows a valid EnVi collections arrangement with

Blender objects in separate collections (Kitchen/diner

is expanded to show the resident object), and the auto-

matically created “EnVi Geometry” collection with

sub-collections representing each thermal zone.

By using the collections system multiple Blender

objects can now be combined into one EnergyPlus zone

e.g. if three objects, all with an EnergyPlus desig-

nation, are placed within the collection ’Bed1’ then

a new collection will be created called ’EN_BED1’

in the ’EnVi Geometry’ collection. Within this

’EN_BED1’ collection will be a single object also

called ’EN_BED1’which contains all the relevant geo-

metry from the three original objects.

An object in Blender, in terms of EnergyPlus, is

specified in the object properties panel in the ’VI-Suite

Object Definition’ tab with the first drop down menu in

the tab. Once “EnVi Surface” has been chosen a sub-

sequent menu sets the type. The type can be ’Construc-

tion’ for a typical construction geometry, ’Shading’ for

a shading geometry and ’Chimney’ for a solar chimney.
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An example of the interface options is shown in figure 60.

Figure 60: EnVi object definition menus

Once an object has been designated as having an

EnVi construction, Blender materials can be associ-

ated with the relevant faces of the geometry to define

constructions. Once a material has been defined for

a face(s) then in the material properties panel, within

the “VI-Suite Material” tab, a button called “Create

EnVi Nodes” can be clicked and this will create a new

“EnVi Material” node tree with the same name as the

Blender material. An “EnVi Construction” node (sec-

tion 4.11.1) is also created within this node tree. Construction details can be provided from the internal database

with this node or layer nodes can be attached to the construction node to specify bespoke layers. EnergyPlus allows

a maximum of 10 layers.

If ’EnVi Zone’ and then either ’Thermal’ or ’Shading’ are chosen the geometry will be considered as part of

an EnergyPlus simulation. A shading object will be used in its entirety in the EnergyPlus simulation with all mesh

faces specified as shading faces. A thermal object requires EnergyPlus specified materials applied to the object

mesh to define the building construction. Blender materials can be applied to the object mesh as usual in Blender.

As EnergyPlus only accepts planar geometry, then if the building is modelled in Blender with a wall thickness only

a single face of the walls should have an EnergyPlus material applied. Where in the construction the face is can

depend on national or building code stipulations but a face near the internal surface of the main insulation layer is

a reasonable starting point. In the material panel for the material applied the tab ’VI-Suite Material’ has a section

’EnVi construction type’. The first menu defines the construction type, which can be:

◦ Wall - Typical external and party wall constructions

◦ Window - Typical glazing constructions

◦ Floor - Typical ground and upper storey floor constructions

◦ Roof - Typical roof constructions

◦ Door - External and internal door constructions

◦ Shading - External shading surfaces

◦ None - No EnVi construction type

Once the type has been selected options are presented to define if the mesh faces the material is associated with

sit on a boundary between two zones, whether they allow air-flow or whether the faces will act simply as thermal

mass with no heat flow passing through the mesh faces. The specific construction make-up can then be selected by

selecting either a pre-set construction or by defining up to 5 layers. If choosing a pre-set construction the user only

needs to input the thickness of each construction element (suggested default are thicknesses are presented to the

right of the thickness entry dialog). If choosing to buildup a construction with layers then for each layer a material

from the VI-Suite database can be selected or a custom material specified. If custom is specified the user must

input the detailed thermo-physical data for the material.

Once a Blender object, which has been designated as a an EnVi thermal zone or shading construction, has

been fully materially defined, the geometry can be stripped down to only that geometry required by EnergyPlus for

simulation. EnergyPlus, like many whole-building energy modelling systems, only requires geometry comprising

of simple planes with construction attributes then associated with them. An EnVi Geometry conversion is there-

fore first required by pressing the ’Export’ button in the ’EnVi Geometry’ node to turn possibly complex Blender

geometry into simplified geometry suitable for energy analysis. During the conversion process only the faces of

Blender objects on layer 1 with a valid EnVi construction material are copied and moved to Blender’s layer 2.

Layer 2 should then be checked to make sure that all desired geometry has been exported. For easy checking the

geometry created on layer 2 is coloured according to construction type:

◦ Roof - green

◦ Walls - grey
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◦ Windows - light blue

◦ Floor - brown

◦ Ceiling/party floor - yellow

An further changes to the geometry should be made on layer 1 and layer 2 used only for checking. After any

material changes the geometry will also have to be re-converted.

Once a valid geometry conversion has been completed, nodes representing each zone will be created in the

’EnVi Network’ node tree, selected with the wind sock icon at the bottom of the node editor. It is here that the

user can specify EnergyPlus zone characteristics. Sockets are also created within these nodes to allow for the

specification of the zone characteristics. These sockets are:

◦ HVAC - for the specification of heating and cooling with a connected HVAC node (section 4.10.2)

◦ Occupancy - for the specification of occupancy with a connected Occupancy node (section 4.10.3)

◦ Equipment - for the specification of equipment gains with an Equipment node (section 4.10.4)

◦ Infiltration - for the specification of air infiltration with an Infiltration node (4.10.5)

Each of these connected nodes can in turn have a schedule node attached for time dependent specification.

Figure 61: EnVi Zone specification

An example complete EnVi zone specification, without an airflow network, is shown in figure 61. In this

example, node connections define the party wall linkage between the two EnVi zones, HVAC and occupancy

for the first zone, and equipment and infiltration for the second. Inter-zone boundaries such as party walls and

floor/ceilings are defined by setting “Zone” as the boundary condition within the “EnVi Construction” node for the

associated material.

In addition to inter-zone boundaries, when airflow surfaces are specified via their material “EnVi Construction”

node, extra sockets are generated within their associated “EnVi Zone” nodes. These sockets should be connected

to specify the nature of air-flow apertures before exporting the EnVi Context. Figure 62 shows an example node

setup with airflow network.
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The brown boundary sockets in each zone node are connected to each other as these boundary surfaces sit on

the boundary between the two zones and as these boundary surfaces have also been specified as an air-flow surface,

the red surface flow sockets are also connected via a “EnVi surface flow” node to specify the nature of the air-flow

aperture. The two zones also each have a openable window specified as an airflow surface, but as these windows sit

at an external boundary they are connected to “EnVi sub-surface flow” nodes via a green sub-surface flow socket.

Once required network connections have been made all nodes should turn the default colour and the EnVi

context can be exported. Any remaining red nodes in the EnVi Network node tree will prevent export.

Exporting the EnVi context will generate an input file for EnergyPlus for each relevant frame. After export

the input files will be registered with Blender’s text editor and they can be edited and saved before simulation if

required. Changes will however be overwritten every time the context is exported.

Once exported the EnViContext node can be connected to the EnVi Simulation node and the simulation initiated.

AKivy window should then appear to estimate remaining simulation time and to display a cancel button, although

if the simulation is simple and very quick there may not be enough time for the Kivy window to appear.

Once the simulation has finished results are available for 2D plotting by connecting the “EnVi Simulation” node

to the “VI Chart” node, or can be exported by connecting to a “VI CSV” node.

Figure 62: EnVi Network connections

5.6.1 EnVi EMS calculations

A basic node setup to use EnergyPlus’ EMS system is shown in figure 63.

The EnergyPlus zone we are controlling is the EN_LIVING_ROOM zone. The sensor within that zone is CO2,

so CO2 should be calculated for that zone. The actuator is set to “Opening factor” which will control the opening

factor or any windows and doors in the zone. These two selections create named actuator and sensor sockets in the

“EMS Zone” node that must be connected to the “EMS Program” node to be registered within EnVi. The socket

names should replicated exactly in the program text detailed below.
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Figure 63: EnVi EMS node setup

An example Blender text file contents to control the node parameters setup is shown in code listing 1. The

contents should be pretty clear: If the internal CO2 within the EN_LIVING_ROOM zone is above 1000 the open-

ing factors of the win_EN_LIVING_ROOM_5 and win_EN_LIVING_ROOM_6 is set to 1. If not the windows

opening factors are set to closed. The syntax of this text should follow that laid down in the EnergyPlus EMS

documentation with the exception that the semi-colons at the end of each line are not required.

IF EN_LIVING_ROOM_CO2 > 1000

SET win_EN_LIVING_ROOM_5_of = 1

SET win_EN_LIVING_ROOM_6_of = 1

ELSE

SET win_EN_LIVING_ROOM_5_of = 0

SET win_EN_LIVING_ROOM_6_of = 0

ENDIF

Listing 1: Example ERL program listing

5.6.2 EnVi Display

3D view port display of EnVi results is not currently supported in version 0.6.

5.6.3 Storing EnVi custom constructions and materials

In general it is recommended that custom materials are added to the builtin database via the buttons in the “EnVi

Construction” (section 4.11.1) and “EnVi Layer” nodes. Be aware that this database is overwritten if updating from

git or replacing the add-on directory, so remember to make a backup of the database if it contains custom entries.

It is however possible to edit the databases directly. Within the VI-Suite add-on directory is a folder called

“EPFiles” within which are a number of json formatted files. EnVi contructions are stored in “Construction_data-

base.json” and materials in the “Material_database.json” file. Before changing either of these files it is a good idea

to make a back-up copy. If editing this file then adding a new material will require adding a material name and a

list of properties to the correct material class. For example adding the entry below to the “Metal” class would add

a “Lead” material.

” Lead ” : [ ” Smooth ” , ” 35 . 3 ” , ” 11340 ” , ” 128 .00 ” , ” 0 . 05 ” , ” 0 . 05 ” , ” 0 . 05 ” , ”5” ]

The first word is the name of the material, the first word within brackets is the surface roughness, and the

following numbers are thermal conductivity (W/m-K), density (kg/m3), specific heat (J/kg-K), thermal absorbtance,

solar absorbtance, visible absorptance, default thickness (mm).

Amaterial added to the “Glass” class may look like
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” C l e a r 6mm” : [ ” G laz i ng ” , ” S p e c t r a lAv e r a g e ” , ” ” , ” 0 . 0 06 ” , ” 0 . 7 75 ” , ” 0 . 0 71 ” ,

” 0 . 0 71 ” , ” 0 . 8 81 ” , ” 0 . 0 80 ” , ” 0 . 0 80 ” , ” 0 . 0 ” , ” 0 . 8 4 ” , ” 0 . 8 4 ” , ” 0 . 9 ” ]

The numbers within the brackets specify default thickness (m), solar transmittance at normal incidence, front

side solar reflectance at normal incidence, back side solar reflectance at normal incidence, visible transmittance

at normal incidence, front side visible reflectance at normal incidence, back side visible reflectance at normal

incidence, IR transmittance at normal incidence, front side IR hemispherical emissivity, back side IR hemispherical

emissivity and thermal conductivity (W/m-K).

Any entry added to the json files should be comma separated from the existing entries in that class.

5.7 FloVi FlowAnalysis

The workflow presented here only applies in full when using a Linux operating system. It is possible on Windows

but requires additional steps which are detailed at the end of this section. On Linux OpenFOAM should be installed.

This can generally be done through the system’s package manager. Once installed point the VI-Suite to the “bin”

directory within the OpenFoam installation that contains the “foamExec” executable using the settings within the

VI-Suite add-on options. Save the settings and then restart Blender.

The Blender scene must at a minimum contain one and only one object defined with the ’CFDDomain’property

in the “VI-Suite Object Definition’menu in the object properties panel. This is the domain that will encompass the

entire fluid simulation. This object can be any shape but must be manifold i.e. a consistent mesh with no holes in

it.

In addition, objects can sit within the fluid domain to act as obstructions to the fluid flow. This geometry must

sit fully within the domain as overlapping geometries are not supported. To identify these objects as obstructions

select “CFD Geometry” in the “VI-Suite Object Definition’ menu. Again these objects can be any shape but must

be manifold.

Finally, empties can be created to act as probes within the domain. These should be positioned inside the

domain, and outside any obstructions, and identified as a probe by selecting ’CFD Probe’ in the object properties

panel.

It is important that all domain and obstruction geometry is manifold i.e. a completely sealed and coherent

sold object. There is a tool in Blender “Select non-manifold” to select object geometry that is non-manifold for

corrective purposes.

The domain and obstructions must also have Blender materials associated with each face as it is with these

materials that we designate the boundary conditions for the fluid flow simulation.

In the material properties panel for the selected material “FloVi boundary” should be selected in the “Material

type” menu of the “VI-Suite Material” section. Once selected various options will be presented to define this

boundary. They include:

◦ Netgen max cell size: As Netgen is used to generate the computational mesh this options set the maximum

size of the cells of the computational mesh at the vertices and edges of the faces associated with this material.

◦ Type: Options here include ’Patch’ for flow boundaries, ’Wall’ for solid boundaries, “Symmetry” for sym-

metrical boundaries, and “Empty” for empty boundaries.

It is advisable that these options are set correctly before OpenFOAM case generation. The following options can

be changed later:

◦ Parameter type e.g. “p type”, “U type”, “Nut type”: sets the type of boundary in terms of the variable being

calculated: “p” is pressure, “U” is velocity etc.

◦ Parameter values: Sets the values for the simulation parameters at the boundaries with the option to take the

values for the domain itself (set during case creation).

The specification of the correct boundary conditions for a particular simulation is beyond the scope of this document,

and often beyond me, so refer to the OpenFOAM documentation and tutorials for boundary selection.
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5.7.1 Generating an OpenFOAM case directory

Once geometry has been created and correctly specified, including setting the correct FloVi boundary “Type” for

the associated “FloVi Boundary” materials, then in a “VI-Suite Nodes” window create “FloVi Case” node from

the “Add” menu. Details of this node can be found in section 4.12.1. In this node the type of simulation can be

specified including whether it is a steady-state or transient simulation, which type of turbulence model to use, and

whether heat (buoyancy) and radiation should be included in the simulation.

In this node, values can also be set for the interior of the domain for the parameters being simulated. It these

values that can be taken by the material boundaries.

Upon clicking the “export” button at the bottom of the node an OpenFOAM case is created within the Open-

FOAMdirectory of the project directory. If a boundary “Type” change is required in the “FloVi Boundary”materials

then make this change and re-export this node.

5.7.2 Generating an OpenFOAM mesh

The VI-Suite uses Netgen (https://ngsolve.org/) to create a tetrahedral domain mesh with the “FloVi Netgen” node

(details in section 4.12.2). This can then be optionally converted into polygonal domain mesh with OpenFOAM.

The “Case in” socket of this node should be connected to the “Case out” of a FloVi Case node.

Options within this node, detailed in section 4.12.2, detail the internal mesh maximum cell size and some

advanced meshing parameters.

Clicking the “Generate” button at the bottom of the node generates a tetrahedral mesh. If OpenFOAM is

available on your system and the correct “bin” directory set in the VI-Suite add-on preferences, then a or polyhedral

can be generated instead. The resulting mesh will be displayed in Blender with an object created in the “FloVi

Mesh” collection. These objects are overwritten on each mesh generation unless it is moved out of the “FloVi

Mesh” collection first.

If there are any errors in the resulting mesh an error message will be added to the “vi-suite-log” file in Blender’s

text editor.

5.7.3 Specifying OpenFOAM boundary conditions

After generating the mesh, the detailed characteristics of the mesh boundary conditions can now be written into the

case directory. This is done with the “FloVi Bound” node (details in section 4.12.3), the “Mesh in” input socket of

which should be connected to the “Mesh out” socket of the “FloVi Netgen” node. This node is useful to make small

changes to the boundaries without having to generate a new mesh. An exception to this is if you want to change

the boundary type e.g. from “Patch” to “Wall”. This will require a new case export and a new mesh generation.

Pressing the “Calculate” button will create the boundary conditions according to the parameters set for the mesh

materials.

5.7.4 Simulating an OpenFOAM case

A“FloVi Simulation” node is required to conduct an OpenFOAM simulaton the “Context in” input socket of which

should be connected to the “Context output” socket of the “FloVi Boundary” node. After calculation Paraview can

be used to visualise results of the simulation. Probe results are also written to the “Results out” socket for export

to CSV with the “VI CSV” node or graphing with the “VI Chart” node.

A complete node set-up is shown in figure 64.

5.7.5 OpenFOAM inWindows

OpenFOAM is not available as native Windows binaries so the workflow is a bit different, and indeed may not

work at all, but I have included this section for people to try.

Netgen forWindows is included in theVI-Suite add-on and Netgen tetrahedral mesh generation can therefore be

accomplished, but the conversion into an OpenFOAM mesh is not possible as this relies on OpenFOAM binaries.

Once a Netgen mesh has been generated a ng.mesh file can be found in the Openfoam folder of the project directory.
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Figure 64: FloVi node setup

If you have OpenFOAM for windows installed, such as the one provided by CFD Support (https://www.cfdsup-

port.com/download-openfoam-for-windows.html), you can open the provided openFOAM terminal and navigate

to the OpenFoam directory in the project directory. You should then be able to run the following command:

ne tgenNeut ra lToFoam ng . mesh

This will create and OpenFOAM tetrahedral mesh in the “Openfoam” > “Constant” directory. Rerunning

“FloVI Netgen” export will process this OpenFoam mesh and create one ready for simulation. Export boundaries

with the “FloVi Boundary” node and then to run a simulation, in the same OpenFOAM terminal enter simpleFoam

if doing a turbulent simulation without buoyancy, buoyantSimpleFoam if running a turbulent case with buoyancy,

or icoFoam if running a laminar simulation. Once the simulation has been completed results can be post-processed

by running

paraFoam − b u i l t i n

5.7.6 Visualising OpenFOAM results

Most of the visualisation of OpenFOAM results is conducted with Paraview (https://www.paraview.org/), which

can be opened automatically after simulation when selecting the “Paraview” option in the “FloVi Simulation” node.

It is beyond the scope of this document to detail a Paraview workflow but it is possible to import back into Blender

the results of Paraview visualisations. By exporting the selected visualisation geometry with the “File > Export

Scene” menu in Paraview, and selecting the *.x3d format. This *.x3d file can then be imported into Blender with

the “File > Import > X3D Extensible 3D” menu entry. Make sure that the “Forward” option is set to “Y Forward”

and the “Up” options is set to “Z Up” for proper rotation of the *.x3d file.

It is also possible to use another Blender add-on for the visualisation of OpenFOAM results: BVTKNodes

(https://github.com/tkeskita/BVtkNodes). Although not production ready BVTKNodes can visualise OpenFOAM

domain slices, streamlines and glyphs from within Blender and is under active development so will get better over

time.

The VI-Suite also offers limited native visualisation of OpenFOAM results. The FloVi Simulation” node can

be connected to a “VI Metrics” node or a “VI CSV” node. Both will visualise the results at probes specified within

the domain: “VI Chart” will produce charts of variables over the simulation time steps, and the “VI Metrics” node

will display the final results at the probe locations.
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Figure 65: Render of ASC imported terrain height around Mount Snowdon.

5.8 Importing GIS building heights

For certain kinds of contextual analysis it can be very useful to import GIS building heights and terrain data. The

following guide works with data produced by Edina Digimaps via an application called Qgis. Qgis is a flexible

GIS application that can import data from many different sources so it is likely that any GIS building height data

can be imported for analysis with the VI-Suite with a modification to the workflow below.

There are at least two types of data you will require from Digimaps: Digital Terrain Map (DTM) data and

building height data. The DTM can be imported directly into the VI-Suite with the ASC import node, but to match

up the buildings with the terrain it is recommended that both types of data are processed with the methodology

below.

Once you have logged in to your Edina Digimaps account select the ’Download for GIS and CAD’ link. From

here you can zoom in on the part of the UK that you wish to have data for and select the specific area you want.

In the ’OSMastermap’ link on the left you can select building heights and from the ’Land and Height Data’ link

you can select the OS terrain 5 DTM. Once these have been selected you can press the order button which will list

the files you have requested. You will need to set the file format of the building height data to Geodatabase. Add a

name for the data and press ’Request Download’. Once the files are ready you will be sent an email with a link to

download the data zip file.

Extract this zip file to your computer and inside you should see two folders: one for the DTM and one for the

building heights. There may be multiple sets of data as Edina provides data for grid map reference squares and if

the area you pick straddles these grid map squares multiple data sets will be in the download.

Open up QGIS and select New Raster layer from layer menu at the top and navigate to the asc file in the DTM

directory .. to be continued.

A render of the terrain around Mount Snowdon in Wales is shown in figure 65.

5.9 Custom Data Processing

For types of analyses that project results on to Blender meshes such as lighting metrics, shadow study and SVF

calculations it is possible to manipulate the results for before presentation. There are two types of manipulation:

simple modifier and scripted manipulations. These options are controlled via the ’Processing’menu in the VI-Suite

display tab. Options in this menu are: ’None’, ’Modifier’, and ’Script’. If ’Modifier’ is selected a text box will

appear where a valid Python expression can be entered e.g. /2 to divide all results by 2; *7 could be entered to

multiply all results by 7; *2+9 could be entered to multiply by 2 and add 9 etc.

An example of the use of this would be to convert shadow study data into the number of sunlit hours. When a

shadow study calculation is conducted the number of total hours, and the number of hours that the sun was above

the horizon, is displayed in the VI-Suite log file. Shadow study results are by default the proportion of hours when
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the sun was above the horizon that a point received direct sunshine. To display the number of total sunlit hours for

the visualisation points entering *X into the text box where X is the total number of hours when the sun was above

the horizon. If the proportion of the total hours that points were sunlit is desired then *X/Y could be entered where

Y is the total number of hours.

If ’Script’ is selected in the ’Processing’ menu an drop-down menu will appear to select a Blender text file.

This file should be opened or created in Blender’s text editor. This text file should define functions in Python

that manipulate the results: a ’resmod’ function, and/or change the legend text entries: a ’restext’ function. This

is advanced functionality and some knowledge of Python programming is recommended as this file must contain

valid Python code.

The ’resmod’ function takes a list of results from each of the visualisation meshes, and returns a modified list

of the same length and in the same order. The ’restext’ function returns a list of strings to be written into the legend

that must be the same length as the number of legend levels set in the VI-Suite display tab. Any functions defined

in this file must be registered with Blender’s driver namespace. Although the scripting method is very flexible it

is especially good at visualising conditional results i.e. manipulating results based on user-specified criteria. A

simple example with comments is shown in code listing 2.

# Impor t t h e main B l ende r Python l i b r a r y

import bpy

# De f i n e t h e resmod f u n c t i o n t h a t t a k e s a l i s t o f o r i g i n a l r e s u l t s

def resmod ( r e s l i s t ) :

# Crea t e a new empty r e s u l t s l i s t

n ew r e s l i s t = [ ]

# I t e r a t e t h ough t t h e o r i g i n a l r e s u l t s

f o r r in r e s l i s t :

# S e t a c o n d i t i o n a l s t a t em e n t ( g r e a t e r than 2000)

i f r > 2000 :

# Add a r e s u l t t o t h e new r e s u l t s l i s t based on

t h i s c o n d i t i o n a l

n ew r e s l i s t . append ( 2 )

# S e t a second c o n d i t i o n a l s t a t em e n t ( g r e a t e r than 1000) i f

t h e f i r s t c o n d i t i o n i s no t met

e l i f r > 1000 :

n e w r e s l i s t . append ( 1 )

# S e t a c o n d i t i o n a l s t a t em e n t f o r a l l o t h e r c o n d i t i o n s ( i . e

. l e s s t han 1000)

e l s e :

n e w r e s l i s t . append ( 0 )

# Re turn t h e new r e s u l t s l i s t

re turn n ew r e s l i s t

def r e s t e x t ( ) :

# Re turn a l i s t o f s t r i n g s f o r t h e l egend . Lowest v a l u e f i r s t .

re turn [ ” <1000” , ” 1000 − 2000 ” , ” >2000” ]

# R e g i s t e r t h e s e f u n c t i o n s w i t h i n B l ende r ’ s d r i v e r namespace

bpy . app . d r i v e r _namespa c e [ ’ resmod ’ ] = resmod

bpy . app . d r i v e r _namespa c e [ ’ r e s t e x t ’ ] = r e s t e x t

Listing 2: Example results processing script
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The above code listing would result in the following visualisation of lux levels on Blender’s mascot Suzanne.

Figure 66: Custom data visualisation

6 Known issues

◦ The Blender 2.8 and above series does not allow for the key-framing of VI-Suite node parameters.

◦ If a VI Display is running when a different Blender file is loaded this can cause an error.

◦ If doing a parametric analysis over more than 70 frames the “VI-Chart” may seg fault Blender. Use the “VI

CSV” node to output a csv file and plot from there instead.

◦ If maximising an area window while the VI-Suite is displaying results in the 3D viewport an error will occur

and “internal error: modal gizmo-map handler has invalid area” will be printed to the system terminal. You

will then need to deactivate the VI display and then reactivate. This is a known Blender bug and you can

register your interest in getting it fixed at https://developer.blender.org/T77419.

◦ If using shape keys to animate an object for a LiVi analysis then these shape keys will be lost if a sensing

surface is also part of the object.

◦ On OS X the Kivy window does not appear in front of the Blender window. Check the desktop for this

window when running a simulation.

◦ If switching between analysis types it is recommended that the complete export process is repeated for the

new analysis.
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